Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional

Ver. 3.2

Instruction Manual

Content of this Instruction Manual

DPP is used for Digital Photo Professional.

In this manual, the windows used in the
examples are from Windows XP.

» indicates the selection procedure of the menu.

Example: [File] menu » [Exit].

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

"2 . Marks helpful information when a problem
arises.

@ : Marks information that should be read

A1/
/TN

before use.

Marks additional information you may find
helpful.

. Marks tips for using the software skillfully.

& Switching Between Pages
Click on arrows on the bottom right of the screen.

(D : next page
€D : previous page

: return to a page you had previously
displayed

® Click on the chapter headings on the right side

of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the [Troubleshooting] » [Shortcut Key
List] in the Help for a list of shortcut keys which
are helpful for quick operation.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is high-performance RAW
image processing, viewing and editing software for EOS DIGITAL
cameras. It is often thought that RAW images are difficult to handle
compared with ordinary JPEG images, but using DPP, you can perform
advanced edits and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. Because image processing does not occur inside the camera
when a photo is taken and the photo has been recorded in the special
form of “RAW image data + Image processing conditions information at
the time of shooting”, special software is needed to view or edit the
image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. And
as for the RAW image, too, you cannot view it as an image on your
computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development” and with EOS DIGITAL is performed using DPP.

With DPP, you can view, edit and print RAW images without having to be
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open an image in DPP, the image is instantly developed and you can
view the image as an image to which image processing conditions at the
time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
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Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim an image and change its size
Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Windows Vista*!
oS Windows XP Professional/Home Edition*?2
Windows 2000 Professional*3

PC with one of the above OS preinstalled

Computer | . Upgraded machines not supported
cPU Windows Vista 1.3GHz Pentium or higher
Windows XP, 2000 | 750MHz Pentium or higher
RAM Windows Vista Minimum 1GB
Windows XP, 2000 | Minimum 512MB
Display Screen resolution: 1024 x 768 pixels or more

Color quality : Medium (16 bit) or more

*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition
*2 Compatible with Service Pack 2 *3 Compatible with Service Pack 4

Supported Images

This software supports the following image types.

Image type/Camera used Extension
EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D Mark I N EOS-1Ds Mark Il
EOS-1D Mark I EOS 5D
EOS 40D EOS 30D CR2
EOS 20D/20Da '
EOS DIGITAL REBEL XTi/400D DIGITAL
: EOS DIGITAL REBEL XT/350D DIGITAL
RAWIMages | £55 peooo+ EOS D2000+:
EOS-1Ds EOS-1D TIF
EOS 10D
EOS DIGITAL REBEL/300D DIGITAL CRW
EOS D60 EOS D30 ’
PowerShot Pro1*2
: Exif 2.2 or 2.21-compatible JPEG
JPEG images images JPG, .JPEG
TIFF images | Exif-compatible TIFF images TIF, .TIFF

*1 Images converted to RAW images that have the “.CR2” extension in CR2
Converter. For information on CR2 Converter, refer to Canon’s web site.
*2 You cannot edit with the DPP RAW image adjustment function.
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Downloading Images to Your Computer Erase dust shot with the image - p.56, p.58
Download images by connecting your cameraand ~ _, 0.6 Erase unwanted parts of an image = p.59 Cor(lzt;%nts at
computer Reduce image noise - p.52 & SIafce
Download images using a card reader - p.8 Correct lens aberration - p.53
Use a Picture Style file - p.49 Basic
Viewing and Checking RAW Images Edit efficiently -p.29 Crzgrer
Quickly enlarge parts of an image = p.10 Edit an image while comparing the image before and _, 0.45
Sort images (check marks) = p.16, p.17 after adjustment ' Advanced
_Display an image _shot simultar_leous_ly as a RAW - .19 Synchronize multiple images - p.46 Operation
image and JPEG image as a single image Display an area beyond the set range as awarning ~ _, 0.47
Display the images in the thumbnail list display at high - .20 indicator (Highlight/Shadow warning) ' | Advalgg_e_d
resolution Restore an adjusted image to its condition at the time _, 0.35 r;lnagle;rimlit;]ngg
Check shooting information such as the shooting date =» p.9, p.20 of shooting
Processing
Editing RAW Images (Adjusting) Printing Laggelr'::r;gsers
Adjust brightness{darkness =>p.11, p.22 Print well on a Canon printer = p.35, p.62, p.63
r g R e e conrf e st 0 0o pco [T
ag%rt?:;)the modulation and contrast of colors = p.25 @ Print with the shooting information = p.60 ’
Make skin tone look healthier (color tone) ->p.25 Wbrinta .thumbnail list of images _ = p.6l
Make the image colors more vivid (color saturation) ~ =» p.25 Qﬁr?tri?])élrrr;astjlttst]e color seen on screen with your =» p.68 Reference
Make an image sharp (sharpness) = p.27
'(A\V\(;Igltljtset gglér:(?eg)e to make color tone more natural - p.23 Conversion of |mag es ——
Change an image to black-and-white or sepia tones 526 Co.n\./ert a RAW image to a JPEG image = p.34,p.74 -
(monochrome) Edit in Photoshop =» p.59, p.75
Trim parts of an image (trimming) = p.31 Perform batch processing ->p.74 @ @
Specify an aspect ratio that matches the size of the - p.31 Edit (adjust) a JPEG image - p.78

paper on which an image is to be printed

SR

[
e gy




1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.
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Starting up DPP

Double-click the desktop icon.

w :

S Double-click

[

DPP starts up and the main window appears.

v

Main window

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility”
from DPP and use.

)
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Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.
When creating a folder, refer to p.41.

1" Digital Photo Professional - [C:\Documents and Settingsicanoniiy Documen
ustment Tools Window  Help

Rk
(%] My Network Places
i3 Travel

Start up EOS Utility.
< © Select the [Tools] menu » [Start EOS Utility].

EOS Utility starts up.
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_ Introduction
EOS Utility Download images.

[@ EOS Utility

[@ EOS Utility — EOS XXX

Control Camera \coe ‘ e s Contents at
RE— a Glance

Starts to download images C||Ck iC
Opernation
Lets you select and download images
Camera settings/Remote shooting ] Advanced
: Operation
u’ Menitor Folder Menitor Folder
Advanced
. 1 U—— Image Editing
and Printing
Connect your camera and computer and turn the = Downloading of images begins. Processing
camera on. The downloaded images are saved in the folder selected in step Lar%eI Numbers
_ ' ) . o of Images
Connect the camera and your computer with the interface cable 1 and are displayed in the main window of DPP. 2
provided with the camera and turn the camera on. =» The downloaded images are sorted by date into folders and
For detailed instructions on connecting your camera and saved. Editing JPEG
computer, refer to the “EOS Utility Instruction Manual” (PDF eoes
electronic manual).
Reference
Index
E@E Advantages of using EOS Utility to download images @

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.



Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

Open [My Computer] » [EOS_DIGITAL] and drag the
[DCIM] folder to the [Desktop].

"= Digital P hoto Professional - [FADCIM]
Fle Edt vew Bookmark Adjustment Tools ‘Window Help

C) puter

- 3 Floppy (A:)
[ WINDOWS HP (C3)
[#5ge Local Disk (D)

(&) My Documenl ts
& My Network Places

The [DCIM] folder is downloaded to your computer.
All images are saved in folder units inside the [DCIM] folder.

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

ettingsicanon\Deskto pADC Ik OOC AN

s
=1 My Computer
G- 3% Floppy (A1)

(< WINDOWS 2P (C1)

% Local Disk (Dt}

-k CD Drive (E2)

=~ EOS_DIGTTAL (F:)

12 pcm

() Shared Documents

-2 My Documents
& My Network Places

{3 102CANON

= Images in the folder are displayed in the main window of DPP.

:@3 Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

|§| Copying to your computer may take time when there is a large
number of shot images saved in the memory card.
For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image

Images downloaded to your computer are displayed as a thumbnails list
in the main window. You can double-click an image to open the edit
window and display the image at large size.

View Images as Thumbnails in the Main Window

) ] Rotate selected image
Main window

A MR

Click to select the image

Display thumbnails of all the images inside the
folder selected in the folder area on the left

|§| When aspect ratio information is attached to the shot image with
a camera where you can set the aspect ratio, the image is
displayed as a trimmed image (p.31, p.86).
For a list of main window functions, refer to p.96.

Changing the Size of Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

< The display changes to the selected item.

)
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Introduction

Enlarge and View an Image in the Edit Window Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.
= : Contents at
Gl
Double-click a wance
ic
Opernation
Advanced
Operation
The edit window appears.
. . . A
The area you double-clicked is enlarged to 100% (actual pixel |ma‘$‘g""£§ﬁf’ng
' size). If you wait for a while, it changes to a clearer display. and Printing
©® Double-click again to revert to the full view. e
Edit window Tool palette ® To change the display position, drag on the image or drag the Processing
. . Large Numbers
R e e e e T o o S| [ree— enlargement display position of the tool palette. of Images
s again - [5]
: “"Z""T“'m“m 'wf_-:__a Tool palette enlargement display position
G " Editing JPEG
Com—_ | Images
= * . — Change the enlargement Reference
R 3 ' display position by
- : . . dragging
oo
It may take time for the image to redraw itself.
Click the [Z3] in the upper right of the window to close the edit L @ @
window. E@E To display an image in an enlargement ratio other than 100%
Select the [View] menu » [200% view] or [50% view]. @

|§| For a list of edit window functions, refer to p.98. |§| You can change the enlargement ratio when you double-click (p.66).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [[ % ]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette

Brightness adjustment ” =]

Reverts the image to
L.J-J oL the original settings
Drag the slider left or right
White balance adjustrment =)
|
Shot settings w
Picture Styls =1 |

Standard - Browse...

-100 -80 -60 -40 -20 00 20 40

Cantrast (0 -
[Linear

Color tone:(0) J

Color saturation: (0} g

Sharpness:(1) 3

The image brightness changes in real time according to the
amount of adjustments.

"2 The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette is saved to an image as data
called a “Recipe” (p.71).

ﬁl For a list of tool palette functions, refer to p.99.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method,
refer to Chapter 2 onwards.

Introduction

Contents at
a Glance

Save (p.33)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.33)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.20)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.34)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process* (p.74)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

You can save * in the main window.
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Printing an Image Exiting DPP

You can print images with a printer. As an example, the procedure to In the main window, select the [File] menu P [Exit].
print one image on one sheet of paper is described here.

Introduction

Contents at

Select the [File] menu » [Print]. a Glance

ic
Opernation

[ ] Advanced
Operation
Advanced
Image Editing
and Printing
The printer’s print settings dialog box appears. [ ] o8I
Print Large Numbers
Iy . : T =» DPP exits. of Images
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins. EdimggizEG
Printing
With DPP, you can perform the following types of printing according to Reference
your requirements. For detailed information on each printing method,
refer to Chapter 2 onwards.
Print one image (p.40) Index
Print with a Canon inkjet printer (p.35, p.38, p.62)

Print with shooting information (p.60)
Printing a thumbnail list (contact sheet printing) (p.61)

00

"2 Exiting DPP without saving adjustments to images @

A confirmation dialog box for saving the images appears. Select [Yes to

all] to save the adjustment contents (recipe) to all the images adjusted. 13



D Advanced Operation

Introduction
A more advanced operation — from efficiently checking multiple images, Editing Efficiently ..., 29
to various ways of e_zditing an ?mage, printing a RAW image with a Canon Changing the Thumbnail Display Position to a Horizontal Contents at
printer and sorting images —is explained here. POSItION ...t 30 a Glance
Efficiently Checking/Sorting Images.................c....... 15 Trimming an Image............cooovniii 31 -
SOrting IMAJES. .....uvveeeeeeieciieeee e 16 Applying Adjustment Contents to Other Images...... 33 Operation
Sorting Images in the Main Window ..................... 17 Saving Editing RESUIS...........ccooiiiiiiiiicieieee, 33
Arranging Images in the Main Window...................... 17 Saving Editing Contents to a RAW Image.................. 33 Ad@ed
Arranging bY TYPE ...ccoovvviieeeecciieee e 17 Saving as a JPEG or TIFF Image.......ccccccceevveeeennnennn. 34 Opgdion
Arranging Freely ... 18 Re-Editing an IMage ........cvoveveeeeeeeeeeeeeeeeeeeeeees 35 PP
Displaying a RAW Image and JPEG Image as a Single Printing an IMage ..........ccoovviiiieiiiiiiiceeeeeece e 35 'f;naggﬁgti};]"gg
IMAGE ... 19 Printing Photographs with Canon Inkjet Printers )
Improving the Quality of an Image in the Main Window ... 20 Compatible with Easy-PhotoPrint EX.................o......... 35 | Processing
Checking Image Shooting Information....................... 20 Printing Photographs with Canon Inkjet Printers Lag%e,r':‘;fgggrs
Editing an IMage ... 21 Compatible with Easy-PhotoPrint..............cccccoeieennnenn. 38
About the RAW Tool Palette.........coooveeiiieiiiieeeeeen, 21 Printing Photographs with a Printer other than the Canon Ediltrir?gg}]aFS)EG
Editing with the Tool Palette in the Main Window.. 21 INKJEL PrINTEIS....ci ittt 40
Adjusting Brightness............ccoceiiiiiiiic e 22 Organizing IMAGES .....c.veveeeeeeeeeeeeeeeeeeee e eeereeeen e 41
Changing a Picture Style ..., 22 Deleting an Unwanted IMage ............ccoveeeveveeeneennnn. 41 Reference
Picture Style File.........ccooiiviiiiiiiciee e 23 Creating a Folder for Saving Images...........c.ccoc...... 41
Adjusting Color Tone by Changing White Balance.... 23 MOVING IMAGES ..o a2 [
Adjusting Color Tone Using Click White Balance....... 24 Moving Images in FOIAErS .........ccovveeeeeeeeeeeeeeeeeeen. 42
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can attach check marks and sort
images into three groups.

Click the [Select all] button on the toolbar.

- Digital Photo Professional - [C:\Documents and Settings]

File Edit Wiew Bookmark Adjustrment Tools  Window  Help

2 ® ®

Toal Select all Clear all

The color of the image frame around all the images changes.

Display the quick check window.
Select the [Tools] menu » [Start Quick check tool].

The quick check window appears.

Click the [Next] or [Previous] button to switch
between images to be checked.

Quick check window

215 C:\Decuments and Settings\Wy Documents\y Plctwreshooo o odIG_0002.CR2

— Double-click

The area you double-clicked is enlarged to 50% view.
Double-click again to revert to the full view.

To change the display position, drag on the image.
To exit, click the [OK] button.
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AL/

> Convenient functions of the quick check window

To check all the images, do not select an image in the main
window

When step 2 is performed with no image selected in the main window,
you can check in the quick check window all the images that were
displayed in the main window.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
keys on the keyboard.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.

|§| The enlargement ratio when an image is enlarged is half (50%) of
the 100% (actual pixel size).

You can change the enlargement ratio to 100%, when an image is
enlarged (p.66).

For a list of quick check window functions, refer to p.101.

Sorting Images

You can sort images by attaching three types of check marks for each
subject or theme.

Attach check marks for sorting.
Check mark

215 C:\Decuments and Settings\Wy DocumentsWy Plctureshiooo o odIG_0002.CR2

» The selected check mark appears in the upper left of the window.

Click the [Clear] button to remove the check marks.
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Sorting Images in the Main Window

You can sort images by attaching three types of check marks in the main
window.

In the main window, select the images you want to
sort and attach a check mark for sorting.

Check mark

o i il

The selected check mark appears in the upper left of the image
frame.
Click the [Clear check] button to remove the check marks.

\\I// . . . . .
:@: To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [View] menu P [Sort] P desired item.

The images are arranged in the order according to the selected
item.
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Sort item

Check mark1 -
Check mark3

Description

Images with check marks take priority and are
sorted in number order.

Shooting Date/Time Images are sorted by shooting date and time

from the earliest.

File name Images are sorted by file name in alphanumeric
order (Oto 9 » Ato 2).
RAW priority Images are sorted in the following order: RAW

images - JPEG images - TIFF images.

-I\@/i- Check mark order

When you have attached check marks 1 to 3, the images are sorted as
follows: If you select 1, the order is 1-2-3; if you select 2, the order is
2-1-3; if you select 3, the order is 3»2->1.

Arranging Freely

Drag and drop the image to the desired location.

=» The image moves to the desired location.
' You can also select multiple images (p.17) and move them.
@ The order of rearranged images is maintained until you exit DPP
or select another folder in the folder area.
® Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

A/

== Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in Preferences to maintain
the order of images without changing the image file names (p.66).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.76).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Tools] menu » [Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

Preferences EJ
General seftings Tool palette Color management

Grid pitch

G4 Pixels(8-256)

Image selection status

[“]Images opened in Editwindow remain selected in main window

Magnification in Edit windowr

@ Fitto window Os50% O100% O 200% ‘

Magnification when the EditEdit image window s double-clicked

O50% ®100% O 200% ‘

AV and JFEG
( Display only CR2 images for CR2 and JPEG files of the same name )

Sort order in main window

[ Retain sart arder

Highlight'shadow warning

Highlight 255 (192-255) -

(0-54) [ |

Shadow il

Quick check toal display
®50% (O 100% (moiré reduction offy

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [Z2B] mark (p.97).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

E\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

» Deleted an image (p.41)

* Moved or copied an image (p.42)

e Checkmarks (p.16, p.17)

» Rotated an image (p.96, p.101, p.102)

 Attached a thumbnail to an image and saved (p.20)

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].

== The extent of the improvement in quality

The quality improves the most when [Large thumbnail] (p.9) is selected.

When [Medium thumbnail] or [Small thumbnail] is selected, the
improvement in quality may be hard to tell due to its size. The quality
also improves for JPEG and TIFF images.

|§| A large number of images may take some time to add.

Checking Image Shooting Information

Select the image for which you want to check the
shooting information.

Select the [File] menu » [Info].

The image information window appears.

Ay

Q= Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the shooting information for that
image will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnail with information] (p.9).
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the [ 5 ]]
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Edit window

Digital Phists Profiessional - [C:\Documts and Sellings \camnbly Decussnts Wiy Piclurm\Photoboos_xo o\iG_0001,CR7]

Tool palette

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, press the <Ctrl> + <Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the image before and
after adjustment (p.45).
You can synchronize multiple images and edit while comparing
them (p.46).
Refer to p.98 for a list of edit window functions, and p.99 for a list
of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/Lens] tool palette are explained in Chapter 3.

Editing with the Tool Palette in the Main Window
By clicking the [Tool] button (p.96) in the toolbar on the main window, the
same tool palette that appears in the edit window is displayed and you
can edit images.
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Adjusting Brightness

Brightness of an image can be adjusted. Move the slider to the right to
make an image brighter and to the left to make an image darker.

RAW [RGB | NR/lens Reverts the image to
Brightness adjustment I|3Il’ the original settings
2 —Enter a numerical value
YWhite balance adjustrment =) HI
| DEE
Shot settings W

Drag the slider left or right

|§| The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you select [Monochrome] and have saved (p.33) the image, you
can always revert to a color image by selecting a Picture Style other
than [Monochrome].

Reverts the image to
the original settings
Select

Picture Style
Standard

i ;
-100 -80 -60 -40
Contrast (1)

[Linear
Colortone: {0y I
Colar saturation:{) I
Sharpness:(l) I

|§| Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast] and
[Sharpness] settings, even if you change the Picture Style (p.67).
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Picture Style Description

Standard The image looks vivid.

Ordinarily, this setting is suitable for most images.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.25).

Portrait

For vivid blues and greens.
Effective for making images of landscapes
impressive.

Landscape

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

Neutral

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

Faithful

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.26).

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

Monochrome

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function of Picture Style. It is a file that
offers effective image characteristics for an image shot in an extremely
limited scene. Refer to p.49 for how to use Picture Style files.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

RAW | RGE | MR/Lens
Brightness adjustment =] H
J 0.0o
YWhite balance adjustment = Reverts the image to
A maE the original settings
e
Select

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.24).

AL/

@< Tune with color tone

To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.25) to get closer to your
requirements.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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)

Introduction
i i i : : The color of the image is adjusted with the point you selected as
Adjusting Color Tone Using Click White Balance 'd ) pomnty
the standard for white.
You can adjust white balance using a selected part of an image as the If you click on another point in the image, the white balance is .
standard for white to make the image appear natural. Using click white adjusted again. g’gfg‘ﬁie"’“
balance is effective when using it in parts of an image where white color To finish click white balance, right-click with the mouse or click
tone has changed under the influence of a light source. the [~ ]] button again.
Basic
RAW |RGE | NR/Lens| | Operation
Brightness adjustment = ﬂl
. Advaficed
Op ion
White balance adjustment E=) HI Click
ic
| Register
| Shot settings v | [_Tune.. Impz;g\éaggﬁ?ng
and Printing
Click on a point that is to be the standard for white. m
Err— Large Numbers
R — of Images
L UTJDE_I :J
E.;_.;_” i =" Editing JPEG
"‘lal e | Images
s
::ﬂ“ o Reference
“ Index

Reverts the ? When there are no white areas in your image

The coordinates of the cursor position and image to the When there are no white areas in your image, you can adjust the white
the RGB values (8-bit conversion) original settings balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point. @

|§| The image is adjusted based on the average value of 5 x 5 pixel

range from the clicked point. ”



Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Picture Style (s Reverts the image to
Standard v the original settings

Browse. .

-100 -8.0 -&.0

-40 -20 00 20 __40 _
it —— Drag the slider left or
right (9 steps)
[JLinear
Colar tone: {0} i
Colar saturation:{0} 1
Sharpnessi0) 1

Display the value of the setting

-I\@/E [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is
checkmarked, the image will become dim.

Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.22) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (p.26).

Picture Style (= | Reverts the image to
Standard v Browse... | the original settings
1 W

. "‘"l"glh" : n!

o k| R
o S W L
100 20 60 -40 -20 00 20 40

Contrast () 2

[Linear
ot OJ Drag the sliders left or
right
Color saturation:{l) —— ' i i
Sharpness:{) J

Color tone:

Display the values of the settings

Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is

adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

ﬁl The adjustment range is —4 to +4 (in 1-stop increments).
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Adjusting Monochrome

When the Picture Style (p.22) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box
(p.22).

Picture Style (= ]| Reverts the image to
" Browse... the original settings

-10.0 -8.0 -0 -40 -20 00 20 4.0
Contrast: (0

[JLinear
Filter effect.(Mone)

(=)
Taoning effect:(Mone) —— ' I i
|

Sharpness:)

Drag the sliders left or
right

Display the values of the settings

Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None Ordinary monochrome image without filter effect.
vellow Blue sky is reproduced more naturally and white

clouds emerge clearly.

Blue sky becomes somewhat darker. The

Orange brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

© Toning effect: You can create a single-color monochrome
photograph to which color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

== Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] (p.25) slider closer to
the right.
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Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.
Move the slider to the right to make an image harder and to the left to

make an image softer.

Picture Style (=
IStandard

v! Browse. .

Contrast: (0)
[JLinear
Colar tone: (0}

Colar saturation:{0)

Sharpness:)

-100 -80 -60 -40 -2

Display the value
of the setting

Reverts the image to
the original settings

Drag the slider left or right

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness may seem unnatural.

|§| The adjustment range is 0 to 10 (in 1-stop increments).

)
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.109). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

R (| RGE R/ Lens

Tone curve assist

(] ] E‘b]l» Reverts the tone curve

Tone curee adjustment =) |-| to the original settings
(_ros J(R](c] s
255_ ngh
Standard

Brightness: N 0
Contrast: N 0
Hue: 0 E _Ij j
Saturation: | ﬂ1 il
Sharpness: | ﬂ 0

The tone curve changes as adjusted.

~@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

® If you click the [[#]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.82).
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Editing Efficiently
The thumbnail display and the edit window are combined and images can

be edited efficiently while quickly switching between images to be edited.
Images to be edited are selected beforehand in the main window.

In the main window, select the images you want to edit.

Switch to the edit image window.

=" Digital Photo Professional - [C:\Documents and Settings]

File Edit wiew Bookmark Adjustment Tools  Window Help

y L
S e ool Select all Clear all
window

Click

The main window switches to the edit image window.

Edit in the edit image window.

Change the size
Edit image window

_ﬂm G RIBT Mgt quskty Rl | Adose F108.

Select the image to be edited
The selected image is displayed as an enlargement
in the middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, press the <Ctrl> + <Z> keys.

)
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-2\@/3 To display an image in an enlargement ratio other than 100%

U MRINIT  eghguakly RN Adobe ROB

Double-click the area you want to enlarge.

L Double-
........ : click

Color sataraten )

Shapans (1)

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view ([Fit to window]).

To change the display position, drag on the image or drag the
enlargement display position (p.99) of the tool palette.

To return to the main window, click the [Main window] button on
the toolbar.

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.67).
You can change the enlargement ratio when you double-click

(p.66).
For a list of edit image window functions, refer to p.102.

Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu » [Change thumbnail
position].

@ If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

)
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information.

Select the image to be trimmed.

Open the trimming window.
Select the [Tools] menu » [Start Trimming tool].

The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.

Trimming window

1715 C:\Becuments and Settings\Wy Documents\y Pictwreshono o adIMG_0001.CR2

__Cancel
—Select a
trimming
ratio

— Drag the
trimming
range

10057, S0 o 30, ) m (90 1 15085 1.5

© The trimming range can be moved by dragging.
@ You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.
@ List of aspect ratios (width : height)
[Free]: You can freely trim an
image.
[Custom]: You can trim an image at
the specified ratio.

Click the [OK] button to return to the main window.
The trimming range frame is displayed in the trimmed image
(p.97).

When the trimmed image is displayed in the edit window or the
edit image window, it is displayed as a trimmed image.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.35).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.97).

 Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.34).

Images that have aspect ratio set display as trimmed images
When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information. However, since the
image is not actually trimmed, you can change the trimming range or
revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.104).

~
-

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.104.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing JPEG
Images

Reference

Index

00

32




Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe].
The recipe is applied to the image.

|§| The recipe (p.71) can be saved as a separate file from the image
and loaded and applied to another image (p.72).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.31) range information can be saved to a RAW image or to a
separate RAW image.

Also, each adjustment made with the tool palette (p.48 to p.53) and dust
erase contents (p.56 to p.59) explained in Chapter 3 can also be saved
to a RAW image.

Select the [File] menu » desired item.

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.

By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.

ExiJPEG["JPG."JPEG)

Quality setiing

Image quality E ] E

Output setting

Resize gefting
[ Resize
i

. |

1spiect rat

Outputresolution | 350 | ap []Embed ICE prafile in image

— Select the save

destination

— Click and save

Enter a file name and

select an image type

=»The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

By saving as explained on this page, a trimmed image (p.31) or
dust-erased image explained in Chapter 3 (p.56 to p.59) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which
occurs when you convert and save an image as a JPEG (p.64).
You can batch convert and save multiple images (p.74).

For a list of [Convert and save] window functions, refer to p.103.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.21), so the “original image data itself” remains
unaffected. Also, the trimming range information of a trimmed image
(p.31) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.33) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with the Canon inkjet printers compatible with the Canon printing
software, Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how
to print photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (Same page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.38)
Printing Photographs with a Printer other than the Canon Inkjet
Printers (p.40)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint EX
(hereinafter, “EPP EX”) :
Simple printing of RAW images
Printing with faithful colors
® High quality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Select the image to be printed. In [Print Quality], select [Quality Priority].
Preferences [g|
Start up EPP EX. Fift | ageneed
Select the [File] menu » [Plug-in printing] » [Print with Easy- [ Spoolpint ob page by page _
h toPrmtEX] Mumber of copies : Copies
P 0 . Printing Order : |BPDale v|
Amount of extenzion of borderless printing : | Drefault v |
Frirt Guiality : Se|eCt
Optior... Quahty
Priority
il Y
[ Ok ] Cancel ] [ Help I
|
Click to close the window
( ) _ Specify the number of sheets to be printed, and then
click [Select Paper].
EPP EX
EPP EX starts up. G e—
In the EPP EX window, select the [File] menu » ==
[Preferences]. o m
h@]ai g_ L ng
D Lo e | e g Bcmoters -v.mm -emeq @_‘7 CI|Ck tO
‘ - increase the
ﬁ&ﬂ el B R | e of
cacills sl il c e ‘_" =i | e e sheets to be
h printed
,mjﬂifhgngﬁmﬂ‘d
The [Preferences] window appears. Click

)
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Select the paper type, and then click the [Layout/
Print] button.

% bew Fhato Print - Lasy Phatofrint [X

e Exif Print
T
I W’;“" S
[@ solect pug . : : n :
@ Layoutfrain "J 1 L J __JI L |
7T L ah Pt Pape Fro %-J--:?xmﬁ Giksty Phots Fager
R Select the
paper type
=T
| |
Click

Specify the layout, and then click the [Print] button.

% bew Fhato Print - Lasy Phatofrint [X

Select the
layout

! b
s Pages

i i r——

Click to print
Printing begins.

? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.68) to
[Perceptual] (p.110) and print.

ALy

-@> Advantages of printing with EPP EX

Printing with faithful colors
When the color space (p.110) is set to SRGB or Adobe RGB (p.59,
p.68), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.
If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

® Printing with a wide color reproduction
When the color space (p.59, p.68) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

@ DPP is also compatible for printing with Easy-PhotoPrint Pro (p.62).

)
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Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with the
Canon inkjet printers compatible with the Easy-PhotoPrint (hereinafter,
“EPP”):

Simple printing of RAW images

Printing with faithful colors

High quality printing using the color reproduction range of Adobe RGB

and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.6 or
later on your computer.

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-
PhotoPrint].

In the EPP window, select the [File] menu »
[Preferences].

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

EPP starts up.

Preferences E|
| Print | Advanced
[[] Spoal print job page by page
Mumber of copies : .\1 3 Copies
Frinting Order : B_y I_Z)a!e__ v
Amount of extenzion of borderless printing : | Defaul v|
Print Quality : u.alit_',‘ F'ri-:-rit_',‘ — SeleCt
Quality
Priority
Defaults
L
0F. l [ Cancel ] [ Help ]
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Introduction
Select the [Advanced] tab sheet and cancel the EPP Cancel the image compensation function, select the
image compensation function. paper type, and then click [Next].
Preferences ‘X| Click to remove check marks Contents at
| Frirt | Advanced a Glance
Image ptimize images automatically CIICk to
Apply Rotate/Trimming to the same images in the same manner remove . .
Wgr;loa:::cl_jta images are rotated depending on the selected lapout : Check mark CIICk OpBearz.lt(I:O n
) Ratate Right
Lapout [ shays: trirn when you select the lapout with the marging Se|eCt the
Set marging o the minimum when pou select the lapout with the marging e i e PRne (efelon Mot paper type

Print filename when you select the index in layout

Freview all layouts of 44 and Letter

Image Select images from multiple folders

Selection Advanced
Image Editing

and Printing

[L oK Jj TR T Processing

Large Numbers

Click to close the window G e

Specify the number of sheets to be printed, and then Editing JPEG

click [Next]. Images
Click to print
Reference
Click
| Click to Index
increase the
number of
sheets to be
printed g 2z M8 -
it of s 18 P Sen - aub 53w ke T ks P P 18 Pl
Select the layout @
P o 50 e =» Printing begins.
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.68) to
[Perceptual] (p.110) and print.

A/

Q> Advantages of printing with EPP

Printing with faithful colors

When the color space (p.110) is set to SRGB or Adobe RGB (p.59,
p.68), this color space is automatically transmitted from DPP to EPP,
allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

Printing with a wide color reproduction

When the color space (p.59, p.68) is set to Adobe RGB and the image
is printed with the Canon inkjet printer, the color reproduction area
widens, and green and blue in particular are reproduced vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.62).

Printing Photographs with a Printer other than the Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.
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Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

The [Confirm File Delete] dialog box appears.

Click the [Yes] button.
The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted from your computer when the [Empty
Recycle Bin] operation is performed on the [Recycle Bin] on the
desktop.

Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.

1" Digital Photo Professional - [C:\Documents and Settingsicanoniiy Documen

File Edt View Bookmark Adjustment Tools Window Help

i) Travel

’ Select the [File] menu » [Create new folder].

The [Create new folder] dialog box appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Moving Images in Folders

You can move or copy folders that contain images, and sort the images

Introduction

Contents at

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.

""" Digital Photo Profassional - [C:\Documents and Settingsicanoniiy Documen

Fle Edt View Bookmark Adjustment Tools Window Help

Deskiop
= (L) My Documents
A My Music

= (2] My Pickures
[=1) Photo
*J My Computer
&) My Network Places

o Trav\

) IMB_0001.CR2 ) n5_oooz|

The images are moved or copied to the destination folder.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the Basic
Operation

Advaficed
Op ion

destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

1" Digital Photo Professional - [C:\Documents and Settingsicanoniiy Documen

File Edt View Bookmark Adjustment Tools Window Help

& % My Computer
) My Network Plages

2 Travel

InG_D001.CR2 i IMG_000Z

= The folders are moved or copied to the destination folder.
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Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

""" Digittal Photo Professional - [C:\Documents and Settingsicanoni4y Documen
Fle Edt View Bockmark Adjustment Tools Window Help

Select

@

IMG_DO0z |

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.
Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu P [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Introduction
Various preferences including advanced image adjustment, automatic Transferring a RAW Image to PhOtOShOp ________________ 59
dust erasure processing, various printing functions for printing out work, .

P g printing prifnting out W Setting Work Color SPace ..........cccceeeveveeeeeeeeenne. 59 | Contents at
and color management are explained here, geared to the user who is o _ _ _ a Clance
competent in the handling of third-party image editing software. Printing with Shooting Information........................... 60

Printing a Thumbnail List (Contact Sheet Printing).. 61 e

Adjusting While Comparing with the Original Image... 45 Printing RAW Images on a High-End Canon Printer.. 62 Operation

Changing How the Window is Split................cooeeee. 45 Printing with a High-End Canon Inkjet Printer ............ 62
Adjusting by Comparing Multiple Images................. 46 Printing with a Large-Format Canon Printer ............... 63 Advanced
Displaying an Area Beyond the Set Range as a Specifying Preferences..........cccccceiveiiiviiiiiieeceeinnnnn. 64 Seeer
Warning Indicator (Highlight/Shadow Warning)....... 4t General Settings...........ccccooeiiiiiii e, 64 AdvEmced
Performing Advanced Editing................c.cccovevvee 48 VIGW SEHINGS ..o oot 66 'gwnadg?g;;;gg
Adjusting White Balance with Color Temperature ..... 48 TOOI Palette ...oooiiveiiie e 67
Tuning White Balance with Color Wheel .................. 48 COlor ManagemMent.............c.ccuovveeeeeeeeeeeeeeeeeeee e 68 |, Processing
Adjusting Dynamic Range ...........cccvvvvvvniiieeeeeeeeeeisinns 49 La;%elr'::rggg ©
Using a Picture Style File.........cccoovivieeeeeeescieceiie s 49 R
Tone Curve Adjustment.........ccooeeeeiiieiiiiiine e ceeeeeiinns 50 EdiltmggJezEG
Example of a Tone Curve Operation ..................... ol
About the RGB Tool Palette ...........cccoeeveieiiiiiiiiiiinnnnn ol
REAUCING NOISE ...t 52 Reference
Correcting Lens Aberration .........cccooeevveviiiiiieveeennnnnn. 53
Compatible Cameras............ccccocviiiiiiiiiii, 53 Index
Compatible LENSES.....ccooiiiiieii 53
Making CorreCtionS..........ueveeeeeiiieeiiiiee e 24
Performing Automatic Dust Erasure Processing...... 56 @ @
Automatic Dust Erasure Processing in the Main Window .. 57
Manually Erasing Dust (Repair Function) ................ 58 @

Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ..o 59 44



Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

In the edit window, select the [View] menu » [Before/
after comparison].

The image divides into a left and right window.
The window on the right shows the image after editing.

Change the image display.

Select the [View] menu » [Change up/down/left/right] » [Up/
down].

The arrangement of the two images changes to top and bottom.
The bottom window shows the image after editing.

|§| Images can also be displayed in the edit image window by the same
operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu » [Display
mode] P [Split single image].

18 e e e

=»One image is divided and displayed on the left and right or top
and bottom.

© To switch between top and bottom, and left and right, perform the
same operation as step 2 on the left page.
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Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and
adjust images while comparing them with each other.

In the edit window, display the multiple images to be
compared.

Align the images.
Select the [Window] menu » [Arrange vertically] or [Arrange
horizontally].
The edit windows are aligned.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

gty ot OB

The other edit windows will also be displayed in the same
position/enlargement ratio.

Move the display position.
If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
other edit windows.
To cancel synchronization, select the [Window] menu »
[Synchronize] again.

)
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the light and dark areas and
preventing excessive adjustment of an image. Where the area on the

Introduction

image has exceeded that set range, you can display the highlighted part Select the [View] menu » [Highlight]. Similarly, select Contlents 2l
in red and the shaded part in blue. [Shadow]. aGlance
On the opened image, if there is an area that exceeds the value
Select the [Tools] menu 3 [Preferences]. entered in step 3, the highlighted part of that area is displayed in A
red and the shaded part is displayed in blue. Operation

Select the [View settings] tab sheet.

Advanced
Enter the warning range for [Highlight] and S R
[Shadow].
ey
General seftings Wigw settings Tool palette Color management I;]nadg ntl| ;]n g
Grid pitch g
&4 Pixels(3-256)
. — Processing
mage selection status
Large Numbers
[“lImages opened in Editwindow remain selected in main window ogl: Im ag es
Magnification in Edit windau
() Fitto window QOs0% O100% O 200% ‘
Editing JPEG
Magnification when the EdiEditimace window is double-clicked ‘ |mages
O 50% @100% O 200%
RAYY and JPEG
Display only CRZ images for CR2 and JPEG files of the same name Referen Ce
Sort order in main windm
[IRetain sort arder
Highlightishadow warning
Highlight 255 32.258) . Index
Shadowr 1] G4 . - @
Guick check tool display
©50% O 100% {moiré reduction off) @ @
Click the [OK] button to close the window. §

@ You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing _
Introduction
This section explains how to use the advanced adjustment function on . : :
the tool palette in the edit window, Tuning White Balance with Color Wheel
Adjustments made using the high-level functions of the [RAW] and White balance can be tuned by moving a cursor in the color direction
[RGB] tool palettes, as well as the functions of the [NR/Lens] tool palette shown in the color wheel. Cgrgstleanr;cgeat
are explained in this section.
In the [RAW] tool palette, click the [Tune] button.
. . . . Basic
Adjusting White Balance with Color Temperature . : Operation
Tune by dragging a point.
White balance can be adjusted by setting a numerical value for color
tempel’ature. Yhite balance fine adjustment
Advanced
) Operation
Select [Color temperature] from the [White balance
adjustment] list box.
Ad\%(j:ed
Imag iting
Set the color temperature. and efting
RAW |RGE | NR/lens o L Enter the values to set _
Brightness adjustment =1 R sl Processing
Large Numbers
ki 0.00 | of Images
White halance adjustrment =] HI Drag
Register... Editing JPEG
Images
— Display the value of the
setting
Drag the slider left or right Reference
Index
@ The adjustment range of color tone is 0 to 359 (1 unit in numerical @
value input), and the adjustment range of color saturation is 0 to 255
|§| The adjustment range is 2800 to 10000K (in 100K units). (1 unit in numerical value input).
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Introduction
Adjusting Dynamic Range Using a Picture Style File
Dynamic range (width of gradation expression) from dark points to bright A Picture Style file is an extended function of Picture Style. It is a file that
points in an image can be adjusted. offers effective image characteristics for an image shot in an extremely 2 Glance
limited scene. With DPP, you can apply a Picture Style file to a RAW
. = ﬂl image.
Ao G You can use a Picture Style file effective for the scene, downloaded from Basic
Ztandard v [ Browse. ] Move downwards the Canon’s web site or your original Picture Style file created with Operation
: Output highlight points “Picture Style Editor” (Picture Style file creating software). When using a
Picture Style file, save it to your computer beforehand.
: . Advanced
— Move to the left or rignt . . . . "
Input highlight pointg Select the image to which a Picture Style file is to be ke
applied.
: . Advapced
B I 1 00 e o0 et 1 e 1 g N1 Click the [BI’OWSG] button. Imag\ajiting
Contrast: (1) J “ - The [Open] dialog box appears. and Pfinting
Gt _ Move upwards ’ [Open] 2 RP
CIear Output shadow points Select a Picture Style file. E—
Sl ] =" - The Picture Style file you selected is applied to an image. Large Numbers
Colar saturation:{0) I} of Images
Sharpness:) I
Editing JPEG
Move to the left or right Images
Input shadow points
The horizontal axis shows the input level and the vertical axis Reference
shows the output level.
Index

|§| The Picture Style files that you can apply to the camera are files with @ @
the “.PF2” extension only. Furthermore, you cannot apply Picture @
Style files with the extension “.PSE” to an image; however if such a
file is registered in the camera and the image is shot, the image will

display correctly. 49



Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.109).

Make adjustments.

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation
method.

Rea | RGE | NR/Lens |

Tone curve assist @ | E+] Eb"I
Tone curve adjustment ) H
(RJ(&] Pl
255 |
8 Curve
Straight . . ;
Right-click with the
S mouse inside the graph
Lurninance R G B .
to display the menu

o ] s
Brighthess: - I D
Contrast 11 = D
Hue: i) ﬂ{_ﬂ- |
Saturation: 1] ﬂ@]
Sharpness: 0 ﬂi_ﬂ_tl

RAW | RGE [ NR/Lens I

Tane cure assist O] | 2o ﬂl

Tane curve adjustment ) H
roa_(RJ(&) ya

255 I Adjusts each channel

Batch adjusts RGB

Click to add a [[] (point)
Adjust by dragging [[]

Brighthess: = ==l n

Contrast: = g !El ]
Hue: g gi_ﬂ__|
Saturation: e EFD_D_i
Sharpness: 0 Eiﬂ |

The horizontal axis shows the input level and the vertical axis
shows the output level.
The maximum number of [[]] is 8.

To delete a [[], either press the <Del> key or double-click on the [[]].

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.67).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.67).

)
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Example of a Tone Curve Operation

Makes medium tones brighter

Makes tones harder

Makes medium tones darker

Makes tones softer

About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB] and [NR/Lens] tab sheets according to your editing
requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than [RAW] tool palette, the image color
may be saturated, or the image quality may deteriorate if you adjust too
much. Therefore we recommend for functions other than tone curve
adjustment and automatic adjustment (p.28), that you adjust images
using the same functions available in the [RAW] tool palette.

Refer to Chapter 5 for explanations on functions of the [RGB] tool
palette other than tone curve adjustment.

== Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/Lens] tool palette (p.100) when
reducing noise (p.52) and correcting aberration (p.53) after you have
made any required adjustments with the [RAW] and [RGB] tool palettes.
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Reducing Noise
You can reduce noise that arises in RAW images that have been shot at Display the image in the [100% view] or [200% view]

NR is an abbreviation for “noise reduction”. You can check the noise reduction effect. T

In the [50% view] or [Fit to window] display, it is difficult to check a Glance
the noise reduction effect, so noise reduction is not applied.

Introduction

Select the [NR/Lens] tab sheet on the tool palette.

; ; Basic
Adjust an image. Operation
Rav | RGE | MR/Lens
Moige reduction Advanced
RAWY Operation
Luminance noize reduction . .
@ Drag the sliders right
off Ly High |mg%\3§ﬁ?ng
Chrominance naise reduction and Pfinting
6) .
Off Lo High Processing
Large Numbers
of Images
TIFF or JPEG
? Additional information
® The noise reduction function does not work Edim‘g i';’EG
Noise reduction cannot be applied when [Viewing and saving RAW ¢
images] (p.64) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.
; ; ; Reference
R ——— ——— '(Ij'?scrz)rae;:i the noise reduction effect, enlarge the image and
Peripheral illumination OFF Noise reduction is applied when the image is displayed enlarged in
— the [100% view] or the [200% view] in the edit window or the edit
Distartion OFF ) ; . N . . . Index
image window. It is not applied in the [50% view] or the [Fit to window]
Chromatic aberratian OFF display or any other window as the noise reduction effect is difficult to -
Calar blur OFF check.
Click the [Apply NR] button. |§| If [Luminance noise reduction] has been set, resolution may be : :
Noise reduction is applied to the image and the image is reduced along with reduction of noise. _
redisplayed. If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

For a list of tool palette functions, refer to p.100. 52



Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that with DPP ver. 3.2, you can only correct RAW images
which you have taken with the compatible cameras and lenses listed
below. JPEG or TIFF images cannot be corrected.

Compatible Cameras

EOS-1Ds Mark Il EOS-1D Mark Ili EOS-1D Mark Il N
EOS-1Ds Mark || EOS-1D Mark || EOS-1Ds
EOS-1D EOS 5D EOS 40D

EOS 30D EOS DIGITAL REBEL L

XTi/400D DIGITAL

|§| For the images taken with a combination of camera and a lens not in
the above lists or with a compatible lens when the extender is
attached, aberration correction function cannot be used. Since it is
unavailable, the aberration correction function is not shown.

Compatible Lenses

*1

*2

*3

*4

EF 14mm f/2.8L USM

EF 14mm f/2.8L Il USM*! *3
EF 20mm /2.8 USM

EF 24mm f/1.4L USM

EF 28mm /1.8 USM

EF 35mm f/1.4L USM

EF 50mm f/1.2L USM*! *4
EF 50mm f/1.4 USM

EF 85mm f/1.2L USM

EF 85mm f/1.2L Il USM*? **
EF 100mm /2.8 Macro USM
EF 16-35mm f/2.8L USM

EF 16-35mm f/2.8L Il USM*! *3
EF 17-35mm f/2.8L USM

EF 17-40mm f/4L USM

EF 24-70mm f/2.8L USM

EF 24-105mm /4L IS USM

EF 28-70mm f/2.8L USM

EF 28-135mm /3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6

EF 28-200mm f/3.5-5.6 USM

EF 28-300mm f/3.5-5.6L IS USM
EF 100-400mm f/4.5-5.6L IS USM
EF-S 60mm /2.8 Macro USM
EF-S 10-22mm f/3.5-4.5 USM
EF-S 17-55mm /2.8 IS USM
EF-S 18-55mm f/3.5-5.6

EF-S 18-55mm f/3.5-5.6 I

EF-S 18-55mm f/3.5-5.6 USM
EF-S 18-55mm f/3.5-5.6 Il USM
EF-S 18-55mm f/3.5-5.6 1S*°
EF-S 55-250mm f/4-5.6 1S*>

Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses*! and EOS 5D camera,

since it is incompatible.

Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses*? and EOS 5D camera
whose firmware version is 1.0.5 or older, since it is incompatible.
Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses*> and EOS 30D camera,

since it is incompatible.

Lens aberration correction functions cannot be used for the image
taken with the combination of the lenses** and EOS 30D camera
whose firmware version is 1.0.4 or older, since it is incompatible.
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Making Corrections Checkmark the items to be corrected.

You can make corrections to one of the four aberrations as below or to
the multiple aberrations at a time.
Peripheral illumination

Distortions

Chromatic aberration (color fringing which occurs in the periphery of S :

an image) 4 1 [ :
Color blur (blue or red color blur which sometimes occurs at the edge _ _ : Rk ) -

of the highlighted area of an image)

In the tool palette, select the [NR/Lens] tab sheet.

Click the [Tune] button.

» The image is corrected and redisplayed.
© Check the results of corrections to peripheral illumination or
distortions in the full view.

® Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200%.
You can lessen the degree of correction by moving the slider for
the item you want to correct to the left.
You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

D Click the [OK] button.

The [Lens aberration correction] window closes and the result of
the corrections is reflected to the image in the edit window and
the image is redisplayed.

The result of the settings of the [Lens aberration correction]
window is also reflected in the tool palette.

In the main window, the [ g)¥ ] mark is displayed on the image to
indicate the lens aberration corrections (p.97).

The [Lens aberration correction] window appears.
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? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

After correcting [Peripheral illumination], some noise may appear in
the periphery of an image.

If this occurs, you can reduce the noise by using luminance and/or
chromatic noise reduction of the noise reduction function (p.52).

The image appears with less resolution after correcting
[Distortion]

After correcting [Distortion], the image may appear with less
resolution.

If this occurs, you can make the image similar to the one before
correction by applying more sharpness with sharpness adjusting
function (p.27).

The colors of the image became weaker after correcting [Color
blur]

After correcting [Color blur], the colors of the image may become
weaker.

If this occurs, you can make the image similar to the one before
correction by making the color deeper with adjusting color tone (p.25)
and/or color saturation (p.82) functions.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur
which sometimes occurs at the edge of the highlighted area of an
image. If conditions do not match, correction cannot be made.

== Correct multiple images at a time

Select multiple images to correct in the main window. Display tool
palette by selecting [Display] menu » [Tool palette]. If you perform
correction procedures (p.54) when tool palette is displayed, you can
apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and paste it to the multiple images (p.33).

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| About [Shooting distance information] slider

When correcting RAW images taken with the EOS-1Ds Mark I,
EOS-1D Mark Il or EOS 40D, it is set automatically according to
the shooting distance information saved to the image.
However, if EF 50mm f/1.4 USM, EF 85mm /1.2L USM or
EF 28-70mm f/2.8L USM is used, it is set automatically to the
right end at infinity position. You can then minutely adjust the
distance by operating the slider while looking at the screen if the
shooting distance is not infinite.
When correcting RAW images taken with other than the EOS-1Ds
Mark Ill, EOS-1D Mark 11l or EOS 40D, it is set automatically to
the right end at infinity position. You can then minutely adjust the
distance by operating the slider while looking at the screen if the
shooting distance is not infinite.

» [Shooting distance information] slider is applied to all the
correction items with check marks.

©® For a list of the [Lens aberration correction] window functions,

refer to p.105.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera 2  About dust-erased images
that can attach this data, can be used to automatically erase dust spots. =
The dust-erased image can be reverted to its original condition
In the main window, select an image appended with at any time
Dust Delete Data. A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
Select the [Tools] menu » [Start Stamp tool]. always revert to the original image by clicking the [Undo] button in the
The copy stamp window appears. copy stamp window or performing the “Re-Editing an Image”

. . ) procedure (p.35).
When the image has redrawn itself, click the [Apply Check dust erasure in the copy stamp window

Dust Delete Data] button. Check dust erasure in the copy stamp window. Images before dust
T T S ——— ) _El erasure are displayed in other windows and you will be unable to
. check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

@ The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.58) or the copy stamp function (p.59).

The image becomes a dust-erased image when converted and

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window. saved
The [@,] mark (p.97) is displayed on an image from which dust The dust-erased RAW image actually becomes a dust-erased image
spots have been erased. when converted to a JPEG or TIFF image and saved (p.34).
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.106.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.

When you move the cursor over the image, the dust erasure
range appears as [O].

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be

unable to erase lines of dust. In this case, use the copy stamp
function (p.59).

Manually Erasing Dust (Repair Function) _
Introduction
You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [(O] and
click.
In the main window, select the image you want to S ———————— S
erase dust spots. a Glance
Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears. Basic
] ) ) Operation
When the image has redrawn itself, double-click the
point from where dust is to be erased. | T —en Click
1/ 2 C:\Documents and Settings'c Wy Doc sy Plctures Pho oMG_0050,0R2 [ 3456 x 2304] : _/I ;":‘ « e Advanced
T —— e m———— YR Exex Sl
Advapced
Imag iting
and Pfinting
Double- - - _ Processing
click »The dust spot within the [O] is erased. Large Numbers
@ Click on another part of the image to continue to erase dust spots of Images
in the image.
® To erase dust in another part of the image, either right-click with Editing JPEG
the mouse, or click the button clicked in step 4 again to cancel dust Images
erasure processing and perform the operation again from step 3.
e o v e i e When the dust spot cannot be erased, [(§)] is displayed.
The display changes to 100% view. _ Click the [OK] button to return to the main window. Reference
The display position can be changed by dragging. The [ & ] mark (p.97) is displayed on an image from which dust
Click the button that matches the dust spot to be spots have been erased.
erased. Index
? Additional information
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.58).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.97) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop. This function is not compatible with Windows Vista. Use
the image transfer function on p.75.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, refer to p.75.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.109) is added. The ICC profile
contains information about [Preferences] (p.68) or work color
space set for each image as described below and the appropriate
color information is relayed to Photoshop.

Setting Work Color Space

A different work color space (p.110) from the default settings (p.68) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.68), this
default setting will not be applied and the individually set color space will
remain.

-:\@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Printing with Shooting Information

You can freely lay out one image on one sheet of paper and print - N .
together with titles and shooting information, etc. "< To maintain the settings

Introduction

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

" C:ADocuments and Settingsicanoniy Documents\My Pictures\Photobooo xx_sodIMG_0001.CRZ Pg|

F'fimEfilmage Text | Settings

Frinter

Canoh xxxx 3 |

hedia 279.4mm % 215.9mm
Letier |
Media orientation
) Portrait (&) Landscape
hedia type
Plain Paper
Print Quality
Standard
Baorderless
Off
Frint profile
ChYI profile
CME settings.
1115 ' Print ' Cancel Apply

Print preview

The image can be moved by dragging.
Drag the four corners of the image to change the size.

For the shooting information, click [El] on the [Text] tab sheet
and select the necessary items in the window that is displayed.

The settings of each tab sheet in step 3 are memorized when the [Apply]
button is clicked (excluding the contents of the [Text] tab sheet). The
settings can be applied to another image when printing.

|§| You can set printer profiles (p.68).
If CMYK simulation has been set, the image is printed in the set
colors (p.68).
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper. _\\@: To maintain the settings

Introduction

Select images to be printed in a thumbnail list. The settings of each tab sheet in step 3 are memorized when the [Apply] c
button is clicked (excluding the contents of the [Text] tab sheet). The S
. . settings can be applied to another image when printing.
Select the [File] menu » [Contact Sheet Prints]. g PP g P g
i ; i it |§| You can set printer profiles (p.68) iR
Specify the required settings for printing, and then et printer p p-56). o _ Operation
click the [Print] button If CMYK simulation has been set, the image is printed in the set
' colors (p.68).
Switches the settings tab sheet Advanced
Operation

" Contact sheet El

Printer | image | Text | Seftings |

Prirter Ad ced
Ganon o ] Imag iting
and Pfinting

hedia 218.9mm % 279.4rmm
o
Lett; v =
Letier | Processing
Media orientation Large Numbers
() Portrait O Landscape of |mages
Media type:
Flain Paper
Frint Quality e
- Editing JPEG
Images
Borderless:
Off
Frint profile
Reference
CMYK profile;
|' Print ' Cancel Apply Index
—

Print preview
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro, you can print with DPP by a simple
operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on
your compulter.

Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].
Easy-PhotoPrint Pro starts up.

Specify the required settings for printing, and then
print.

? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

Functions set in DPP that are not applied to printing
Specified output resolution (p.64) and CMYK simulation (p.68) are not
applied.

ALy

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When the color space is set to SRGB or Adobe RGB (p.59, p.68), this
color space is automatically transmitted from DPP to Easy-PhotoPrint
Pro, allowing you to print with faithful colors.

If you set Apple RGB, ColorMatch RGB or Wide Gamut RGB, the
image is printed with Adobe RGB color space.

® Printing with a wide color reproduction
When the color space (p.59, p.68) is set to Adobe RGB and the image
is printed with the high-end Canon inkjet printer, the color
reproduction area widens, and green and blue in particular are
reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install the
imagePROGRAF Print Plug-In for Digital Photo Professional on your
computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for photograph
printing, and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.64) and CMYK simulation (p.68) are not
applied.

A/

-@> Advantages of printing with the imagePROGRAF Print Plug-In

Printing with faithful colors

When a color space is set (p.59, p.68), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.59, p.68) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Operation

Advapced
Imag iting
and Pfinting

Processing
Large Numbers
of Images

Editing JPEG
Images

Reference

Index

00
©

63




Specifying Preferences

You can change the various functions of DPP in the Preferences
window. Check the contents of each window and set.

Also, depending on the item, a detailed explanation may be available,
so refer to each window.

Select the [Tools] menu » [Preferences].
The [Preferences] window appears.

Select the tab sheet, specify the settings, and then
click the [OK] button.

Preferences E|

General settings iew settings Tool palette Colar management

Startup folder
(%) Last displayed folder
() Specified folder

Save recipe
(%) Display message when adding file
() Add to file automatically

“iewing and saving RAYW images
. 5 Wiewlsave RAVW images at high gquality
() High guality (reeammended) Mairé is reduced and the MR tool palette can be used

[J+iew images at hioh speed (moiré reduction off)
() High speed

JPEG image quality
[CIRemove block noise and mosguito noise

Default value of output resolution ‘

. dpif1-60000)

AtEOS WMility startup
[]Editimage window enakled at EQS Utility startup

General Settings

You can specify the folder that opens when DPP is started up, and

image quality of displayed and saved RAW images.

Preferences

General setlings View settings Tool paletts
Startup folder
(%) Last displayed falder

() Specified folder

Save recipe
(%) Display message when adding file
() Add to file automatically

‘ Viewwing and saving RAW irmages
Wiewlsave RAW images at high quality
@ High guality (recommended)
[CIwiew images at high speed (moiré reduction off)

() High speed

JPEG image guality
[]Remove hlack noise and mosgquito noise

Defaultvalue of output resolution

330 dpit1-60000)

‘ ALEOQS Liility startup
[[] Edit imane window enahled at EOS Utility startup

Calor management

Moiré is reduced and the MR tool palette can be used

X]

Cancel
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Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.52) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.52)
to reduce the luminance noise and chrominance noise.
You can check the effects of the false color reduction processing and
noise reduction function in the edit window or the edit image window
in the [100% view] or [200% view] enlargement display.
In the [50% view] or [Fit to window] display of the edit window, edit
image window, or any other window, the effects of the false color
reduction processing and noise reduction function are difficult to
check, so they are not applied.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]

If you checkmark [View images at high speed (moiré reduction off)],
when the image is displayed in the edit window or the edit image
window, false color reduction processing is not applied.
As the [View images at high speed (moiré reduction off)] setting is the
same as [High quality] other than for display of the image, the image
undergoes false color reduction processing when it is saved and the
noise reduction function is also available.

[High speed]
Since false color reduction processing is not applied, the display
speed of a RAW image in the edit window or the edit image window in
the [100% view] or [200% view] enlargement display, and the time it
takes to save a RAW image is less than in [High quality].
You cannot use the noise reduction function (p.52).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

? What is the difference between the [High quality] and [High
speed] displays?

The display image quality of [High quality] and [High speed] is the same
except when the image is displayed in the [100% view] or [200% view]
enlargement display in the edit window or the edit image window.

© JPEG image quality

You can improve the quality of a JPEG image by reducing their noise
characteristic that occurs when RAW images are converted to JPEG
images and saved (p.34, p.74).

This setting is also effective for JPEG images that have been saved with
a different name.

? The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is
reduced. When the compression rate is low, the effect of noise reduction
is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as
JPEG or TIFF images (p.34, p.74).
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View Settings

You can specify settings relating to the display.

Preferences
General settings Wiew settings Tool palette Color management
Grid pitch
fi4 Pixels(3-256)
Image selection status
Images opened in Editwindow remain selected in main window
Magnification in Edit window
(%) Fitto window ) 50% 100% O 200%
Magnification when the EAiVEdit imade window is doukle-clicked
&0 @100% (200%
AW and JFEG
Display only CR2 images for CR2 and JPEG files of the same name
Sort order in main window ‘
[ Retain sort order ‘
Highlightishadow warning
Highlight 265 (192 2559 .
Shadow 0 (0-54) . ‘
Quick checktool display
(&) 60% () 100% (maoiré reduction off) ‘
ok Jl cance

]

Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.18).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you exit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you exit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.47).
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) Introduction
Tool Palette Default sgttlhgs of RGB too! palgtte | |
You can specify settings for the tool palette When the setting is changed, the setting will be applied when DPP is
P g P ' restarted. Contents at
a Glance
Preferences E| 7 . ) )
General settings View seftings Tool palette Colar management - Changes are not app“ed to the edlted Image
Default settings of RGH tool palette H H H H H BaSiC
A Tons cure intrpation et Even if the dgfault_settlng_ is changed, the new default s_ettlng is not Operation
SRETRE e S e applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
O Luminanse R 6 B O straight erased) images. Change each one individually.
Histograrm display Advanced
) Before adjustment Operation
(&) After adjustment L. ) 3
Modified Picture Style settings
T”g”;;ifﬂj?;?;: Gl You can select whether the [Color tone], [Color saturation], [Contrast] Advemced
ol R and [Sharpness] settings will be changed or retained, when you change Imag\aji_ting
the Picture Style. and Mnting
e @ If you checkmark the checkbox, the [Color tone], [Color saturation], :
B ek L [Contrast] and [Sharpness] settings will be changed to match the Processing
T camera’s preset settings, when you change the Picture Style. Lag%elrlr\]lgr;gsers
[ 5ame for Main windw and Editwindow | If you remove the check mark, the [Color tone], [Color saturation],
| [Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style. Editing JPEG
Images
‘ Reference
fiiorcans]| e cancelpl
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

General settings Yiew seftings Tool palette Color management
Default settings of Work calor space

®sRGH O Apple RGE

() Adobe RGE ) ColarMatch RGB

(O Wyide Gamut RGE

Calor matching settings

For display

) sRGAE

() Moniter profile

Printing profile
--- Mone - v

ChYK simulation profile ‘
- Mone - b ‘

2UFIC

Rendering intents when using Easy-PhatoPrint
) Perceptual

(%) Relative Colorimetric

[ Ok [ cancel

Default settings of Work color space

You can select from five types of color space (p.110) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.34,
p.74) or printed (p.35, p.38, p.40, p.60 to p.63).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the edit
window (p.98) and the edit image window (p.102).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.59).

® Display setting (color setting of the monitor)

Where a profile (p.109) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you checkmark [Use the OS settings], the color profile set in
Windows will also be applied in DPP.
If you are using multiple monitors, only the profile of the primary
monitor is applied to DPP.
Checkmark the [Monitor profile], click the [Browse] button and in the
dialog box that appears, select a profile for your monitor.

5@5 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
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Setting of printing profile (color setting of the printer)

Where a profile (p.109) is attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile. The profile that has been set is applied to
all printing (p.40, p.60, p.61) except for linked printing (p.35, p.38, p.62,
p.63).

? The adjustment function of the printer driver should not be
used

Even if you set a printer profile, if you use the color adjustment function
of the printer driver, the image may print in colors different from those
displayed on screen.

=@> Automatic settings with linked printing

If you are printing with a Canon inkjet printer (p.35, p.38, p.62, p.63), a
profile is set automatically even when the [Printing profile] setting is not
performed. This allows you to print easily with faithful colors.

Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.110) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.96, p.98,
p.102) in the bottom of the main window, edit window and edit image
window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.110) for printing
with Easy-PhotoPrint (p.35, p.38).

The rendering intent is ordinarily set to [Relative Colorimetric].

> When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptuall.
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4 Useful Functions for Processing Large Numbers of RAW Images

Introduction

For users shooting a large amount of RAW images, the convenient

function of batch processing large amounts of RAW images is explained
Contents at

here. a Glance
Utilizing Adjustment Contents (Recipe)................... 71 R
Saving Recipes as a File.......ccccoovevveiiiiiiiiiii e, 72 Operation
Loading and Pasting ReCIPeS..........cccevvvvvviiiieeeeeeennnns 72
Copying a Recipe and Applying to Another Image..... 72 Advanced
Batch Apply White Balance to Images (Personal White i
BalanCe) .......ouuuveiiiiiii i 73 Adionoed
Registering Personal White Balance.......................... 73 Ir;r?(?le; Eﬁltiit:]rgg
Applying Personal White Balance .............ccccccceeeee. /73 ——
Batch Save as JPEG or TIFF Images (Batch L;;ngrs
PrOCESSING)...uuiiiiieiiie e 74 of Iméges
Batch Transfer Images to Image Editing Software.. 75
Batch Change the File Name of Images.................. 76 Edifﬂ{,‘ggﬂ;EG
Changing the File Name of Images in the Order in the
MaiN WINAOW .......coveiiiiiiiiiiiiiiiiieeeee e eeeeeee e 76
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and

applied to another image.

You can edit images efficiently by selecting and adjusting one image
from large numbers of images shot with the same shooting environment
and batch applying the adjustment results to a large number of images.

i|PEB | NR/Lens
Brightness adjustment m

&

3 0.00

y

‘White halance adjustment
Vol
v

Shat zettings

Ficture Stvle

Standard “ Browse

14

00 -80 -60 -40 -20 00 20 4.0

Contrast: (0) J
[Linear

Calar tane:{) i |

Color saturation:{0) I

Sharpnessi{1) i

RAW image data

I \N
Lyrd

Contents adjusted using the tool
palette can be handled
individually as a recicpe file

>

(extension “.vrd").

|§| The adjustment contents of JPEG images can be saved as a recipe
file (extension “.vrd”) and loaded and applied to another image in
the same way as with RAW images (p.78, p.92).

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB] and [NR/Lens]). For this reason, other editing content such as
trimming or dust-erasure (copy stamp) is not included in the recipe
data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Introduction

Saving Recipes as a File
Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu P [Save recipe in file].
The [Save recipe in file] dialog box appears.

Select the destination folder, enter a file name, and
then click the [Save] button.

? Check the contents of a recipe file by pasting to an image

When you do not know the contents of a recipe file, paste it to an image
and check the settings in the tool palette. When only a few settings are
adjusted, we recommend you use a file name that describes the
contents or that you separately record the adjustments as text
information.

Loading and Pasting Recipes

Select the image to which arecipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select arecipe and click the [Open] button.
The recipe is applied to the image.

Select the image from which arecipe is to be copied
and then select the [Edit] menu P [Copy recipe to
clipboard].

The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe to
selected image].

The recipe is applied to the image.
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance
Adjust the white balance (p.23, p.24, p.48).

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance E|

Renister current setting in personal white balance

Current setting:  Click white halance

1 w || Clickwhite balance

| Import. || Export. | || 0K Cancel |

? To use the registered personal white balance on another
computer

In step 3, click the [Export] button to write as a file.

Copy the file to another computer.

In DPP on the other computer, display the window of step 3.

Click the [Import] button and in the window that appears, select the
copied file.

Applying Personal White Balance

In the main window, select the image to which white
balance is to be applied.

Click the [Tool] button on the toolbar.
The tool palette appears.

Click the personal white balance number button that
Is to be applied.

[RGB | NR/Lens|
Brightness adjustment | =] [|
5 — —— 0.00
Yhite balance adjustment =) ﬂl
2]
|Ehnt settings vl
Picture Style =1 |

IEtandard “ Brovwse.

L3 | f i j . 4 i
-100 -80 -60 -40 -20 00 20 40

Contrast: (0) J
CLinear

Colortone: {0} 3

Colar saturation:{0) I

Sharpness:i1) I

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar (p.96).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

Batch settings EI
IMG_0001.CR2 Save folder
IMG_0002.CR2 7
IMG_0003 CR2 CiDocuments and Settingsicanonity Documentst Browse.
IMG_0004.CR2
IMG_0005.CR2 IR IGED
IMG_00o7.cR2 Kind offile ExiJPEG b
IMG_0008.CR2
IMG_0009.CR2 Image guality 10
IMG_0010.CR2
IMG_0011.CR2
IMG_0012.CR2 Dutput setiing
IMG_D013.CR2 Oulputresolution | 350 | g [Z/Embed ICC profile
IMG_0014.CR2
IMG_0015.CR2 Resize setting
[ Resize
File narne
O Current file name
(=) Mewr file name
String Seguence number
DPP_ ooo1
[[]5ave sequence number
Ex: DPFP_0001.JFPG, DPP_0002.JPG
Image transfer settings
[f—
[ corwertRawvimages only N[ Execute || cancel |
. > |

The processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
processing dialog box.

In the processing dialog box, click the [Exit] button.

"2 [Save] cannot be performed

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.33, p.91) to edited RAW images.

A/

-@> Skillful batch saving

© While saving is being performed, you can continue working in
another window
Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

|§| If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.31,
p.86) or dust-erased image (p.56 to p.59, p.88 to p.91) actually
becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, refer to p.107.
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Batch Transfer Images to Image Editing Software _
Introduction
You can transfer multiple images to image editing software. The Select Photoshop CS.
software used here as an example is Adobe Photoshop CS. In the [Open] dialog box, select Photoshop CS, and click the
_ _ _ _ [Open] button. ST Al
In the main window, select multiple images to be The [Open] dialog box closes and [Image transfer settings] in the a Glance
transferred. [Batch settings] window is set to Photoshop CS.
Click the [Batch process] button on the toolbar (p.96). Checkmark [Open image using software]. Basic
The [Batch settings] window appears. Operation
Perform settings required for transferring (e.qg. file O
format). Advanced
Operation
Click the [Browse] button.
Batch settings E| Advanced
IMG_0001 . GR2 Save folder I Image Editin
Mo ERres CiDocurments and Setingsicanomily Docurmentst Click the [ExeCUte] button. ' an(?Printingg
:mgigggg'ggg e & =»The processing dialog box appears and batch transfer begins.
IMG_0007.CR Kind offle it JPEG v =»When the first image has been transferred, Photoshop CS starts )
S _ . . . Procegésing
s Imace gualty 310 up and transferred images are displayed in transferred order. Larg bers
IMG_0011.CR2 OUbteet .I:
IMG_0012.CR2 utput setting or Images
IMG_0013.CR2 Outputresolution | 350 dpi [¥]Embed IC profile
IMG_0014.CR2
IMG_0016.CR2 Resize sefling
i Editing JPEG
Images
File name
) Current file name Reference
(&) Mewr file name
String Sequence numhber
DFP_ 0001
[ 5ave sequence number IndeX
Ex: DPP_0001.JPG, DPFP_0002.JPG...
Image transfer settings
00
The [Open] dialog box appears. @
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Batch Change the File Name of Images

In the main window, select multiple images of which Changing the File Name of Images in the Order in the Main Window
the file names are to be changed.

Introduction

When you change the order of the images in the main window (p.18),
Contents at

Select the [Tools] menu » [Start Rename tool]. you can change in one operation the names of the files for the images, 2 Glance
The rename window appears.

in the order they were rearranged.

Specify the required settings and click the [Execute] Change the order of the images in the main window Basic
button. (p.18). Operation
[~ (C:A\Documents and SettingsicanoniMy DocumentsiMy Pictures\Photoboooc xc sod |n th e m al n W| ndOW, Sel eCt m u |t| ple |m ag eS Of Wh | Ch
File name Extension -
DPP “ | Shooting DaterTime w | Seguence number £ Do not change - th e fl I e n am es are to b e C h an g ed . gd\é?gt(':ce)g
Basic Settings Format settings p
o seauencs nurter Select the [Tools] menu » [Start Rename tool].
Fit to main window o001 [[]save sequence numbar
g:rlwzgt?r:;eDalemme Shooting DaterTime AdVanC.eq
Yourtont D3 g Select [Fit to main window]. Image Editing
YMM-DD 3 and Printing
[ca ename
o Il i " C:ADpcuments and Settingsicanonkiy Do
Proceflsing
Qriginal File Mame Madified File Name F”E—name — e Larg bers
IMQCLUDD1 cR2 -~ DPP_D6-08-13_0001 CR2 3 DFP | Shooting Datel] of Im ges
IMG_0002.CR2 DPP_06-09-13_0002.CR2 ” . -
IMG_0003.CR2 DPP_06-09-13_0003.CR2
IMG_0004.CR2 DPP_06-09-12_0004.CR2 A BaSiC SETtir‘l 5
MG D1ie C2 DPF 0021 1-0018 CR2 1 ’ Editing JPEG
IMG_0007.CR2 = DPP_06-09-12_0007.CR2 Sl:lrt |ma es
IMG_0008.CR2 DPP_06-09-12_0008.CR2 = = A = g
IMG_0008.GR2 DPP_0R-03-12_0009 CR2 [@ Fitto main wmdnw]
IMG_0010.CR2 DPP_06-09-12_0010.CR2
=R Lo | e :J (_JFile name
m S () Shaoting DatesTime e
Processing begins and the file names are changed. Specify the required settings (p.108).
To copy an image, checkmark [Copy Rename]. .
ndex
Click the [Execute] button.
? Changes cannot be made when the file name is duplicated The file names are changed and the order in the main window is
If a file name in red text has appeared in [Modified File Name], the file maintained.
name has been duplicated. Changes cannot be made if even one file
name has been duplicated. Change the settings so that duplication does
not occur. @

|§| For a list of the rename window functions, refer to p.108. 26



5 Editing JPEG and TIFF Images

Introduction
DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained. Cgrgstle;ntgeat
Editing JPEG and TIFF Images...........ccceevvvieeeeeeenn. 78 R
About the RGB Tool Palette ..........ooveeveeveieieieeeeeeennn, 78 Operation
Automatically Adjusting Brightness and Color (Tone
CUIVE ASSISE) covviiiiiiee e 79 AN
Adjusting Brightness and Contrast...............c.cc.cc....... 80 ok
Adjusting Color Tone Using Click White Balance....... 81
Adjusting Hue, Saturation and Sharpness.................. 82 |m':g\<lea£gﬁidng
Tone Curve AdjuStMmENt.............eevveiiiiiiiiiieeeeeeeeeeeeenn, g3 (2ndEunting
Adjusting Dynamic Range ...........cccceeveveeeeeeeeeeenenne. 84 [ processing |
Reducing NOISE ...cc..vuiiiiiiiiiiie e 85 Laégfe.r'#‘égé’ﬁ's
TrimMmMING an IMage......cccooveeeeiiiiiieeieeeeee e 86
Performing Automatic Dust Erasure Processing ..... 88 Edifﬂrﬁfs’EG
Automatic Dust Erasure Processing in the Main
WINAOW .. 89
Manually Erasing Dust (Repair Function)................ 90 Reference
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCHION). .. 91 Index
Saving Editing ResultS........cccovvviiiiiiiiiiiiiceen 91
Saving Editing Content to an Image.............ccccevvvenn. 91
Saving as a Separate Image .........ceceeiiieeerieeeiinnnnnnn. 92 @ @
Applying Editing Contents to Another Image........... 92
PHNTING ..o 92 @
Re-Editing an Image.........cccccoeeeeviiiiiii e 92
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/Lens] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any nhumber of
times.

IMG_0001.PG ]

RaWw | RGE | WR/Lens

Tone curve assist vl 3 %)
Tone curve adjustment = |
(ree J(RI(e) A

255

S S

™ JPEG, TIFF imag

i MY
-
5 vrd )
Brightness: i [g =

contrast 9 10 Contents adjusted using the tool

Hue: 3 sl | palette can be handled
Saturation: : 3 o100 | individually as a recicpe file
Sharpness oo ||| (extension “.vrd”) (p.71, p.92).

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.91), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.71, p.92).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than [RAW] tool palette, the image color
may be saturated, or the image quality may deteriorate if you adjust too
much. Therefore, take care not to adjust your images to an excessive
degree.

You can adjust RAW images with the functions in the [RGB] tool palette.
However, for functions other than tone curve adjustment (p.83) and
automatic adjustment (p.79), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically
adjust the image tone curve (p.109). You can select the degree of
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

Raw | RGE | NRALens

Tone cure assist (@ EH [ Reverts the tone curve
Tone curve adjustment - | to the original settings
(_ree (R[] i
255 High
Standard

Brightness: 1 0
Contrast: 3 ]
Hue: 0 ﬂ _d |
Saturation: | ﬂ1 an
Sharpness: B ﬂ 0|

The tone curve changes as adjusted.

@< Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

¢ Images which have been shot with the proper exposure

» Images where the brightness is unbalanced

* Images which are too dark

¢ Images which have extreme backlighting

® If you click the [[ @] button, the tone curve as well as the [Hue]
and [Saturation] revert to the default settings. Take care when
adjusting the [Hue] and [Saturation] individually (p.82).
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Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted.

Brightness: Move the slider to the right to make an image

Contrast:

brighter and to the left to make an image darker.
Used to adjust modulation and degree of contrast

)

Introduction

Contents at

of color. Move the slider to the right to make a Glance
RawW | RGB | NR/Lens | contrast of an image stronger and to the left to
Tone curve assist | ] Ebﬂl make contrast weaker. )
Tone cure adjustment =) ” Basu_:
d Operation
[ reB_J(R](G) 2
255
Advanced
Operation
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
0|
o] Drag the sliders left or Ed||tr|rr56|;EG
Brightness: @ 1] }1 right
Contrast . [0~ Enter numerical values
s ~ T ED Reference
Saturation: - 1 = E 100
Sharpness: a E 0
Index

@ The adjustment range is —100 to +100 (in 1-stop increments when

entering a value). 80



Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[#]] button.

F{F';'I.l'l.l'-l RGE |-NRJI|..EHS I
Tone curve assist [ | ] IZ'fbH
Tone curee adjustment = |

Cres J®© [ﬁi

255

o |
o]
Brightness: —_— D
Contrast: — D
Hue: — ED
Saturation: — —— ﬂ
Sharpness: 0 ED

Click on a point that is to be the standard for white.

" Digital Photo Professional - [C:\Documents and Settingsicanoniy DocumentsiMy Pic... |ZHE|E|
File Edit ‘Wiew Adjustment Tools Window Help

(1595, 830) 220,223,236 High quality Adohe RGB/sRGE

|
The coordinates of the cursor position and
the RGB values (8-bit conversion)

=» The color of the image is adjusted with the point you selected as
the standard for white.

@ If you click on another point in the image, the white balance is
adjusted again.
To finish click white balance, right-click with the mouse or click

the [[_# |] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

|§| The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.
The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.67).
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Introduction
- : : Hue: Move the slider to the right to make color tones
Adjusting Hue, Saturation and Sharpness g
more yellow, and to the left to make color tones
You can adjust hue (tone) and saturation and make the overall redder.
atmosphere of an image harder or softer : - : Contents at
: Saturation: Move the slider to the right to make the color a Glance
deeper, and to the left to make the color weaker.
RAw | RGB | NR/Lens | ) Sharpness: Move the slider to the right to make an image .
e 0] x| o] harder, and to the left to make an image softer. OpBe?Zlc(i:on
Tone curee adjustment = |-|
- Cre EE 7|
255 Advanced
Operation
Advanced
Image Editing
and Printing
Processing
Large Numbers
of Images
o

Editi PEG
| es

Brightness:

0
Contrast: [0
= Reference
Hue: 5 |j —
Saturation: b|[100 —}— Enter numerical values
Sharphess: H n J Index
? Sharpness is unnatural
Drag the sliders left or right Adjust sharpness with the window view set to [100% view], [50% view]
or [200% viewl]. If the view is set to [Fit to window] (full view), the
sharpness will seem unnatural.

)

ﬁl The adjustment range is —30 to 30 for hue, 0 to 200 for saturation, p—
and 0 to 500 for sharpness (in 1-stop increments when entering a

value).
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.109).

Select the tone curve mode and interpolation

method.
Rew | RGE | NR/Lens |
Tohe curve assist @ | 2+ Eb"l
Tone curve adjustment ) H
(][] Pl
255 |
& Curve
Straight . . .
Right-click with the
S mouse inside the graph
Lurinance R G B .
to display the menu

__I_‘

[0 ] (235 |
Brightness: = Ig |0 [
Contrast 11 = [0 |
Hue: = i) ﬂ!_ﬂ__l
Saturation; 1] g[mu ]
Sharpness: B Ei_ﬂ |

Make adjustments.

RAW | RGE [ NR/Lens I
Tone curve assist O] | 2o ﬂl
Tane curve adjustment ) H

Cres ()6 (6] |
|

255

Brightness: = ==l | :|
Contrast: = g !El ]
Hue: 3 gi_ﬂ_ |
Saturation: g EFDD [
Sharphess: ] &0 |

Adjusts each channel
Batch adjusts RGB

Click to add a [] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[], either press the <Del> key or double-click on the [[]].

The histogram display changes according to adjustment. You can

also fix the histogram display to the display before any

adjustments (p.67).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.67).
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Introduction
Adj usti ng Dynamic Range |§| The setting range of shadow points is 0 to 247 (in 1-stop
D : idth of aradati o) f dark points to briaht increments when entering a value).
ynamic range (width of gra ation expression) from dark points to brig The setting range of highlight points is 8 to 255 (in 1-stop Contents at
points in an image can be adjusted. : :
increments when entering a value). a Glance
The histogram display changes according to adjustment. You can
Move downwards also fix the histogram display to the display before any
Output highlight points adjustments (p.67). Basic
Operation
RAW | RGE | NR/Lens | |
Tone cure assist rall ey =) Hl
Taone curve adjustment b«H— Reverts the Advanced
rRGE  |[RI[G] A || image to the Operation
Output 2550 original
highlight point settings Advanced
numerical Image Editing
value and Printing
Processing
Move to the Move to the Large Numbers
right left of Images
Input shadow Input highlight
points points o
Editi PEG

Output shadow —a

pointnumerical o, 12s51— Input highlight

value Brightness: - 3 o | pointnumerical Reference
Contrast d : o ] value

Input shadow — —

oint numerical : - [0 ]

\F;alue e J oj0 | Index
Saturation: N ﬂimu ] - @@
Sharpness: d - w0 |

Move upwards @ @

Output shadow points @

The horizontal axis shows the input level and the vertical axis shows
the output level.



Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/Lens] tab sheet on the tool palette.

Adjust an image.

O Drag the slider right

Click the [Apply NR] button.
Noise reduction is applied to the image and the image is
redisplayed.

Display the image in the [100% view] or [200% view]
enlargement display.
You can check the noise reduction effect.
In the [50% view] or [Fit to window] display, it is difficult to check
the noise reduction effect, so noise reduction is not applied.

? To check the noise reduction effect, enlarge the image and
display it

Noise reduction is applied when the image is displayed enlarged in the
[100% view] or the [200% view] in the edit window or the edit image
window. It is not applied in the [50% view] or the [Fit to window] display
or any other window as the noise reduction effect is difficult to check.

|§| If [Chrominance noise reduction] has been set, color bleeding
may occur along with reduction of noise.
For a list of tool palette functions, refer to p.100.
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information.

Select the image to be trimmed.

Select the [Tools] menu » [Start Trimming tool].
The trimming window appears.

When the image has redrawn itself, select a ratio and
drag the trimming range.

1715 C:\Becuments and Settings\iy Dacumentsiiy Picturesbooo o odllG_0001.CR?

—— Cancel

»— Select a
trimming
ratio

— Drag the
trimming
range

1037, S04) - (3006, BB m (138 x 1263 1.50)

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

List of aspect ratios (width : height)

[Free]: You can freely trim an image.
[Custom]: You can trim an image at the specified ratio.

/4 Click the [OK] button to return to the main window.
=» The trimming range frame is displayed in the trimmed image
(p-97).
=» When the trimmed image is displayed in the edit window or the
edit image window, it is displayed as a trimmed image.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming window or performing the “Re-Editing an Image” procedure

(p.92).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.97).

* Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate
image

The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.92).

Images that have aspect ratio set display as trimmed images
When aspect ratio information is attached to the shot image with a
camera where you can set the aspect ratio, the trimming range is
displayed based on the aspect ratio information. However, since the
image is not actually trimmed, you can change the trimming range or
revert to the condition before trimming.

When reverting to the condition before trimming is performed based
on the aspect ratio information at the time of shooting, click the
[Reset] button. Also, if you want to cancel all the trimming range, click
the [Clear] button (p.104).

The image is displayed in its trimmed condition.

A/

> Convenient functions of the trimming window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming
window. With the trimmed image displayed, click the [Copy] button
and then click the [Apply All] button. This will apply the trimming range
to all the images selected when the trimming window is displayed.

|§| For a list of the trimming window functions, refer to p.104.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

In the main window, select an image appended with
Dust Delete Data.

Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

1/ 2 C:\Dacuments and Settings\canon\by Documents\My Plctures P hotoloood o odG_0050. 183 [ 34546 x 2304]

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [@,] mark (p.97) is displayed on an image from which dust
spots have been erased.

‘2 About dust-erased images

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.92).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

@ The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.90) or the copy stamp function (p.91).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.92).
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> Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

|§| For a list of the copy stamp window functions, refer to p.106.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »

[Apply Dust Delete Data].
Dust spots in all the selected images are erased in a single
operation.
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If the dust spot is dark in color, click the [ ] button, and if
the dust spot is light in color, click the [ ] button.

When you move the cursor over the image, the dust erasure
range appears as [O].

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.91).

Manually Erasing Dust (Repair Function) _
Introduction
You can erase dust spots in an image by selecting them one by one. Place the dust spot to be erased within the [(O] and
click.
In the main window, select the image you want to o ————————————— S
erase dust spots. a Glance
Select the [Tools] menu » [Start Stamp tool].
The copy stamp window appears. Basic
] ) ) Operation
When the image has redrawn itself, double-click the
point from where dust is to be erased. ] || ST
1/ 2 C:\Documents and Settings'c Wy Doc sy Plctures Pho oG _0050, JPG [ 3456 x 7304] —/ = - Advanced
- S — — Operation
Advanced
Image Editing
and Printing
Double- - - _ Processing
click » The dust spot within the [O] is erased. Large Numbers
@ Click on another part of the image to continue to erase dust spots of Images
in the image.
® To erase dust in another part of the image, either right-click with Editifes] PEG
the mouse, or click the button clicked in step 4 again to cancel dust [ es
erasure processing and perform the operation again from step 3.
e o v e i e When the dust spot cannot be erased, [(§)] is displayed.
The display changes to 100% view. _ Click the [OK] button to return to the main window. Reference
The display position can be changed by dragging. The [ & ] mark (p.97) is displayed on an image from which dust
Click the button that matches the dust spots to be spots have been erased.
erased. Index
? Additional information
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1to 3in “Manually Erasing Dust (Repair
Function)” (p.90).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [8,] mark (p.97) is displayed on a corrected image.

Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.78 to p.85) as
well as the trimmed range (p.86) and dust-erasure (p.88 to p.91)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

Your adjustments are saved to the image.
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Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.78 to p.85)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.86) or dust-erased image (p.88 to
p.91) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.34)

Batch save as JPEG or TIFF images (batch processing) (p.74)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image =

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.33)

Utilizing adjustment contents (recipe) (p.71)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.35)

Printing with shooting information (p.60)

Printing a thumbnail list (contact sheet printing) (p.61)

Printing RAW images on a high-end Canon printer (p.62)

Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.78 to p.85), so the “original image data itself”
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.86) or dust-erased image (p.88 to
p.91) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.91) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu » desired item.

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.

el An Index is provided at the end of the chapter for you to easily find
o information you are looking for.
Troubleshooting........ccuuiiiiiiiiici e, 94
Deleting the Software (Uninstalling) ........................ 95
List of Main Window Functions.............ccccceeevvveen. 96
Image Frame Information in the Main Window and Edit
IMage WINAOW..........cooeeiiiiiiiiiiiiiieee e 97
List of Edit Window Functions ...............cccoeeeevvveenn. 98
List of Tool Palette Functions ...............c.ccceeeeeeeeeenn. 99
List of Quick Check Window Functions.................. 101
List of Edit Image Window Functions .................... 102
List of Convert/Save One Image Window Functions 103
List of Trimming Window Functions....................... 104
List of Lens Aberration Correction Window Functions 105
List of Copy Stamp Window Functions.................. 106
List of Convert/Save Multiple Images Window (Batch
Processing) FUNCLIONS ........c.ccoviiiiiiieccceeeeei 107
List of Rename Window Functions......................... 108
(€ (0151 Y= 1 Y P 109
100 L= 111
About This Instruction Manual ...............ccccceeeee. 115
Trademark Acknowledgments..............cceevvvvnnnnnn. 115
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Troubleshooting

If DPP is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install the software if a user setting other than [Computer
administrator] privilege or [Administrator] privilege is selected. Select
the [Computer administrator] privilege user setting in Windows XP or
the [Administrator] privilege user setting in Windows 2000. For
detailed information on selecting the user setting, refer to your
computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements does not meet. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

Images do not display properly

Images that are not supported by DPP do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly (p.3).

When a dust-erased image (p.56 to p.59, p.88 to p.91) is displayed in
a window other than the copy stamp window, it is displayed as it was
before dust erasure was performed. Check dust-erased images in the
copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.99).

PowerShot Prol RAW images cannot be adjusted with the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.99).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.9, p.21, p.96, p.101, p.102),
trimming (p.31, p.86), dust erasure (copy stamp) (p.56 to p.59, p.88 to
p.91) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.99).

Color appears weak in the image when viewed with
other software

® A RAW image which has a color space other than sRGB set (p.59,

p.68) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with SRGB color space. In this case, set the RAW image color space
to sRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.68) and a profile for a printer is
set up correctly (p.68), the color of a printed photograph and the color
of an image on screen can be more closely matched. Printing with a
Canon printer (p.35, p.38, p.62, p.63) automatically sets up printer
profiles, so you only need to set the color of the monitor to bring the
colors closer together.

When printing with Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.39).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.41).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with the EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and PowerShot Prol may not display
image information (p.9, p.20).

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under the Computer administrator/Administrator privileges
when uninstalling the software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Select the [Start] button » [All Programs] ([Programs]
in Windows 2000) » [Canon Utilities] P [Digital Photo
Professional] » [Digital Photo Professional
Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
=» The software is uninstalled.
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List of Main Window Functions ©.9

Cancels selection of all images

Selects all images

Shows/hides the tool palette (p.99)
Shows/hides the folder area

Switches to the edit image window
(p.102)

Check marks (p.17)
Removes check marks (p.17)
Image rotation (90 degree units)

Folder path

Toolbar*! ) ) ) (2 ) _ : Batch conversion/
Clear al Chack Check Checkd Cle: Rotate left  Rotate right SaV| ng (p ) 74, p ; 75)
@ Deskiop
=) My Documents
= My Music
=) My Pictures
[=1-{Z3) Phata
=]
4§ My Camputer
&) My Metwark Places
10 Travel
L e
F
Folder area*?
IMG_0007. CR2 IMG_0006:GR2 1MG_0009.CR2 o
ar
- e
B e
R METDE G HE R | g GO0 2 R B e | SRR i A e R R A el ] T [ e
Display mode**
. . 3 .
Information dISplay* —4(1929,895) : 167,172,195 High quality Recipe data: Yes Murnfer of images: 15 Hurnber of selected images: 1 CMYK

Recipe attachment status (p.71)  Number of images = Number of selected images = CMYK simulation display (p.68)

*1 To switch between show/hide, select the [View] menu » [Toolbar]. *3 Displays the coordinates of the cursor position and the RGB values (8-
*2 The images inside the folders selected here are displayed in a bit conversion) when click white balance was performed with the tool
thumbnail list on the right. palette.

*4 The item selected in [Veiwing and saving RAW images] (p.64) of the
[Preferences] window is displayed.
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Image Frame Information in the Main Window and Edit Image Window ®.9.p.29)

Information displayed when [Large thumbnail] (p.9) is selected

""" Digital Photo Professional - [C:\Documents and Settingsicanoniy Documents\y Pictures\Photobooor s xx]

File Edit “iew EBookmark Adjustment Tools window Help

Edit image o Sele Clear all
window
@ Dieskbop r
Check mark {2 Fiy Documents - Copy stamp mark
(p.16, p.17) g My Music (p.56 to p.59, p.88
=2} My Pictures to p.91)
[={-7) Phata

Lens aberration
correction mark

(p.54)

Trimming range*®
(p.31, p.86)

1) st
-_J My Compuker
& My Metwark Places

Brightness adjustment
value*! (p.22)

Aperture*3

White balance icon*!
(p-23)

IMG_0007 . CR2

\
‘ RAW adjustment mark*1*4
RGB adjustment mark*1*>
Unsaved editing content mark

File name

Image type*2

Shutter speed*3

*4 Displays in an image edited with the [RAW] tool palette in the edit
window and the edit image window.

*5 Displays in an image edited with the [RGB] tool palette in the edit
window and the edit image window.

*6 When aspect ratio information is attached to the shot image with a

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.19).
[RAW] is displayed in RAW images. (In [Small thumbnail] (p.9), [R] is
displayed.)

In PowerShot Prol RAW images, [RAW] is not displayed.

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

a trimmed image.

camera where you can set the aspect ratio, the image is displayed as
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List of Edit Window Functions .10, p.21)

Introduction

Path and file name of image Tool palette*! (p.99, p.100)
7' Digital Photo Professional - [C:\Documents and Settingsicanoniy Documents\My Pictures\P hotoboooc soc sodIMG_0001.CR2] |T||E|r5_(| IMG_0001.CR2 & Contents at
e : . _—— RAW [RGB | NR/Lens| a Glance
File Edit ‘Wiew Adjustment Tools  Window  Help
—— Brightness adjustrent I
J 0.00
wihite balance adjustrent k=) I BaSi(_:
» Operation
| Shot settings v|[_Tune.. ]
Ficture Syle =Y Advanced
| stangar v| [ Browse.. Operation
Advanced
Image Editing
and Printing

-100 -0 -60 -40 -20 00 20 40

Contrast: (0) i Processing
[CLinear Large Numbers
Color tane:{0) —_—r of ImageS
Color saturation: {0 ——
Sharpness:ily Al e
Editing JPEG
Images

Reference

(24281580) : 40, 60, 32 HighI uality F{Pu'u'u'fl" Adobe RGE ON:IYK

‘ Index
Information display*? CMYK simulation display (p.68)
Display mode** (p.64) Image color space*3 and work color space (p.59, p.68) @ @
*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW]. @
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.64) of the
bit conversion). [Preferences] window is displayed.
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List of Tool Palette Functions
RAW Tool Palette (p.21)

Brightness adjustment

Brightness adjustment (p.22)

3 000 |

White balance adjustment
ﬂ ; e gister White balance adjustment
|Sh0tsettings v| Tuhe... (p.23, p.24, p.48)

Picture Style . .

r— Picture Style settings (p.22, p.49)

v| Browse..

Dynamic range adjustment (p.49)

"W

-100 -80 -60 -40 -20
Contrast: (0)

0o 2o 40
+——1— Contrast adjustment (p.25)

[JLinear
Calaor tone: {0

Linear setting (p.25)

Color saturation: {0

| “ |} color tone and color saturation
1 adjustment (p.25)

Sharpness:(1) -~ Sharpness adjustment (p.27)

— Enlargement display position*!

RGB Tool Palette (p.51)

IMG_0001.CRZ [®
RAW | RGE | NR/Lens

Tone curve assist

Automatic adjustment
(tone curve assist) (p.28, p.79)

(o] 2|z
Tone cune adjustment = |

(_ree J(RJ(GJ # H— Click white balance (p.81)

255 |

Tone curve adjustment
(p.50, p.83)

—— Dynamic range adjustment (p.84)

255
Brightnass: — = = 1] .
_ - ‘ : L Brightness and contrast
-y B o I adjustment (p.80)
Hue: = =1 . :
. B Hue and Saturation adjustment
Saturation: el g 5 E 100 (p.82)
Sharpness: f ﬂ 1]

Sharpness adjustment (p.82)

— Enlargement display position*!

*1 If an image is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears when
[Docking display] (p.67) has been set and the edit image window (p.102)
has been enlarged.
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NR/Lens Tool Palette (p.52)
(When a RAW image is selected)

IMG_1001.CR2 3]

R | RGE | MRILens

Moise reduction

RAIN

(Luminance hoise reduction
d
L it Loy High

( Chrominance noise reduction

3
off Loy

.

High

TIFF ar JFEG

s

Lens aberration correction [ Tune... ]
Feripheral illumination CFF
Distortion OFF
Chramatic aberration QOFF
Colar blur OFF

Luminance noise reduction for
RAW images (p.52)

Chrominance noise reduction for
RAW images (p.52)

— Apply NR button (p.52)

— Lens aberration correction (p.54)

— Enlargement display position*1

*1 If an image is displayed enlarged, the enlargement display position

can be moved by dragging. The enlargement display position appears

when [Docking display] (p.67) has been set and the edit image
window (p.102) has been enlarged.

NR/Lens Tool Palette (p.85)

(When a JPEG or TIFF image is selected)

IMG_1001.JPG
Rawy | ReA | MRILens

=

MNaoise reduction

RAn

Lo

TIFF or JPEG

-

|

Chraminance noise reduction
g

Hiah J

Zhrot

off Loy
shulyf HE —
s aberrationica
2riphe hanliab=Telelg)
B ]= Cafge]ute]

Chrominance noise reduction for
JPEG and TIFF images (p.85)

— Apply NR button (p.85)

— Enlargement display position*1
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List of Quick Check Window Functions .15, p.16)

Check mark display

Path and file name of image 50% view/full view*! Displays the image in full screen*?

' 2/15 C:\Documents and Settings\My Documents\My Picturesboooc xx_sxodIMG_0002.CR2 |Z|[E|fg|

[ A0% view H Full screen ]

Removes check
Check mark Clear:}i marks (pl6)
ENENE D— Check marks (p.16)

l Pre\iious “ et ] )
' ' Switches between
displayed images

—— Displays the image

L_ Image Information l lnfOFmatlon W|ndOW
[ Rotate e “ Rotate right] (p.20)

: : Image rotation
(90 degree units)

*1 In [50% view], you can move the display position by dragging.
*2 To return to the normal screen, press the <Esc> key.
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List of Edit Image Window Functions ©.29.p.30)

Shows/hides tool palette Image path and file name
Shows/hides thumbnail display area Shows/hides Enlargement ratio of displayed image Image rotation (90 degree units)

Switches to main window (p.96) Switches between displayed images Batch conversion/saving

" | Digital Photo P ents and Settingsicanoni\My DocumentsiMy Pictures\Photo (p ’ ! p )

File Ecjt ‘iew Adjustment Tocs Help

Toolbar E@ A

Rotate left  Rotate right

RAW | RGE | MR/Lens

|Elrightmess adjustrment I

3
|White balance adjustment iﬂ
ﬂ Register

| snot setings v [Tune
[Picture 5tvle 5
‘Standard v| Browse...
[ T T T T T

—— Tool palette
' (p.99)

Thumbnail display area*3

-loo -80 -60 -40 -20 00 20 40

Contrast: (0) ——
[Linear

Colar tone:(0) —r

Calor saturation: (0} —_—

Sharpness:{1) a—

Display mode*> (p.64)

Information display*2

(129410213 116,131,177 High c;ualily RP.W/{ Adobe RGE OMYK—|
\ 1
Image color space*! and work color space (p.59, p.68) CMYK simulation display (p.68)

*1 RAW images are displayed with [RAW].

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion).

*3 Displays images selected in the main window. The image selected
here is enlarged and displayed on the right.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences]
(p.66).

*5 The item selected in [Viewing and saving RAW images] (p.64) of the
[Preferences] window is displayed.
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S E——

List of Convert/Save One Image Window Functions 34 .
Convert and sa E|| Contents at
] Save in: | | Phata vl 0 * e &= a Glance
Types of image
5
Type of image Extension (G Basic
Exif-JPEG JPG B"ﬁcifnii’li Operation
Exif-TIFF 8bit TIF E%
TIFF 16hit TIF "
Deskiop HHCH_KK_RX T Advanced
Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG Save destination Operation
TIFF 16bit+Exif-JPEG | .TIF/.JPG ,./
My Documents Advanced
Image Editing
»_11)3 and Printing
. ky Computer .
File name | LProcssatr)]g
o - — x arge Numbers
\-1] File name: ENEREE v| | sae J{— Save of Images
by N;t-u:nrk Save sstyper | ExiJPEG("JPG,".JFEG] | | Cancsl |
Quality setting Editing JPEG
Image guality Ia JPEG compression rate*3 Images
Resolution*1
Qutput setting
Output regolution | 340 dpi FEmbed 1CC profile inimage
Embeds of ICC profiles*2 (p.109) Reference
Resize sefting )
[Resize
Size changing*4 ] [ Index

*3 The setting range is 1 to 10. The higher the numerical value, the higher @ @

the image quality becomes. @

*4 The larger of the two values set in [Width] and [Height] is applied to the

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.59, p.68) information that is set in an image is attached
to an ICC profile.

—
Even if you remove the check mark from images that have been set to longer edge of an image and change its size.
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.59,
p.68), the ICC profiles are embedded automatically. 103



List of Trimming Window Functions 31 ps6

Cancels the all the trimming (aspect ratio) information

' 115 C:\Documents and Settings\My DocumentsiMy Picturesboone sxox xox\IMG_0001.CR2 |:|@E]
| Fursereen H——Full screen display/returns to normal screen
cear [ Rresst —— Reverts to the condition when the image was shot
e Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1
Upper left coordinates of trimmed range (you
{x v can also enter numerical values)
1037 a04 . .
—— — Size of trimmed range (you can also enter
e x[138 | numerical values)
= Copies the trimmed range and applies (pastes)
(Ccow )| ¢« it to another image*2

— Applies the copied trimming range to all other
images*?2

Displays borders around a trimmed range
+——+1—Level of opacity outside a trimmed range

[ e [ ner Jt—Switches between displayed images*?
” Cancel ]

I_T_|Sh0w barders

Opacity

l Ok

{1037, 504) - (3026, 1830) = (1989 x 1326) [ 1.50]

Trimming range

*L |f [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming
window is displayed.
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=" Lens aberration correction

=y

Shooting distance information
. N }_

[JPeripheral ilumination

[ Distartion

[JChromatic aberration

List of Lens Aberration Correction Window Functions @54

—— Enlargement display section*1

- Reverts to the condition when the
image was shot

—— Shooting distance information
slider (p.55)

jl— Peripheral illumination correction

— Distortion correction

— Chromatic aberration correction

—— Corrects blue chromatic aberration

[ Calar blur

[ Mavigatar

Color blur correction
Shows/hides position of

enlargement display section

Grid display

Corrects red chromatic aberration

*1 The area you clicked on the image is displayed at 200%.
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List of Copy Stamp Window Functions .56t p.59,p.8sto p.o1)

1F 2 C:\WDocuments and SettingsicanonWy Documentsi\y Pictures\Photoboooc xoc sodIMG_0050.CH2 [3456 x 2304] |:||E|r5__(|

| 100%view || Funsereen +4— Full screen display/returns to normal screen

[ aesyDustoeiete et H— Applies Dust Delete Data (p.56, p.88)

Repair Repair

(Ll | {231 M—Types of dust to be erased (p.58, p.90)

—1 Specifies the copy source (p.59, p.91)
[JFix copy Source position —— Fixes the copy source position (p.59, p.91)

-
Fen type

(%) Brush O Pencil
\.

Types of stamps (p.59, p.91)

Sets the size of the dust erasure range (p.58,
p.90) or copy range (p.59, p.91) in a range of 5

(v
Radius

g Tl to 100 (in one pixel units) (you can also enter a
numerical value)
Redo
v - Restores/redoes the image
[ ] * Copies the dust erasure range or copy range

and applies (pastes) it to another image
— Switches between displayed images*

Set ko 100%: view to perfarm stamp operation

* Operates when you have selected multiple images and the copy
stamp window is displayed.
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List of Convert/Save Multiple Images Window (Batch Processing) Functions .74

Batch settings

Introduction

Contents at

—
_ ) IMG_D001.CR3 Save folder L a Glance
Flle names Of ImageS to be :mg—ggg%ggg . CADocuments and Settingsicanonbly Dbcumentsl Save deStlnatlon
batch saved IMG_0004.CR2 '
IMG_0005.CR2 File farmat
IMG_0007 CR2 Kind offile EXFJPEG v/) Types of image Basic
e (foaee | —) _ | 3
IMG_0010.CR2 ooty Type of image Extension
Embeds ICC profiles*2 (p.109) a0tz ca A Al Exif-JPEG JPG
— e S K ¥1Emsed 0 rofe Exif-TIEF 8bit TIF Advanced
Resolution — Operation
IMG_0015.CR2 " e saie TIEE 16Di P
— e it TIF
: N Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG
Size changing*4 : _ -
TIFF 16bit+Exif-JPEG | .TIF/.JPG Image Editing
and Printing
(~File name —— JPEG compression rate*3
) Currentfile name processing
il Large Numbers
il [ of Images
) Mew file name .
E‘.trﬂ - ] Sequence num Flle name
DPP_ TR Editing JPEG
[ 8ave sequence number Images
Ex: DPP_0001.JPG, DPP_0002JPG..
( Image transfer settings Reference
MAGE UsingEom: Batch transfer to other image editing
L software (p.75)
1 Save
Images to be converted are [ Caonvert RAW images anly ][ Execute | ][ Cancel ] Index
limited to RAW images*>
*1 The setting range is 1 to 60,000 dpi. *3 The setting range is 1 to 10. The higher the numerical value, the higher
*2 Color space (p.59, p.68) information that is set in an image is attached the image quality becomes. @ @
to an ICC profile. *4 The larger of the two values set in [Width] and [Height] is applied to the
Even if you remove the check mark from images that have been set to longer edge of an image and change its size. @
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.59, *5 Appears when you click the [Batch process] button (p.96, p.102)
p.68), the ICC profiles are embedded automatically. without an image selected in the main window or the edit image

window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.
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List of Rename Window Functions .7 _
Introduction
= C:ADpcuments and Settingsicanoniy Documentsihy Pictures\P hotobooo: xoc 3ok kad
p 3 Contents at
File name Extension . a Glance
| DPP w | Shooting Date/Time vH Sequence number vi iDo not change v| SetS the new flle name
. )
( Basic Settings ( Forrmat settings )
. . . Sort Sequence numhber Basic
Order in which images are sorted @ Fitto main window [ oo0t | [JSave sequence number Operation
() File name ; ;
Shooting Date/T, . .
| O shooting Datermime et Sets the format of information
|*ear Maonth Day v| . he fil
Check mark to apply the same —— o +JPEG mages ) In the Tile name Ad q
: [rv-Mm-DD | vance
name to RAW images and JPEG (" CIcopy Rename _ ) Operation
images recorded simultaneously ([ Insert underbar )
Check mark to copy the images Advanced
Click the [Browse] button and set Original File Mame Madified File Narme Image Editing
the save destination IMG_0001.CR2 ~ DPP_06-08-13_0001.CR2 ~ and Printing
IMG_0001.JPG DFF_06-08-13_0001.JPG
IMG_0002.CR2 4 DFF_06-08-13_0002.CR2 L
IMG_0002.JPG DFF_06-08-13_0002.JPG .
IMG_0003.CR2 = DPP_06-08-13_0003.CR2 - Processing
IMG_0003.IPG DFF_06-08-12_0003.0PG Large Numbers
IMG_0004 CR2 = | DPP_06-08-12_0004.CR2 of Images
IMG_0004.JPG DFF_06-08-12_0004.JPG
IMG_0005.CR2 DFF_06-08-13_0005.CR2
IMG_0005.IPG DFF_06-08-13_0005.0PG
o 000 CR2 B | Dvrteos1a Mgk v Editing JPEG
< Images
Execute l l Cancel
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small of even image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
you view on a monitor and the color of an image you have printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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) ) ) Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard .
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in R
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. . -
ColorMatch RGB : A slightly wider color space than sSRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
printing industry, suitable for simulation of ";‘naggﬁgt'it;]”gg
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
Y . .
Rendering intent o images
Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below. »
) . Editing JPEG
Perceptual : Before and after conversion, all colors are Images
Color range that can be converted to maintain the relationship between
seen by the human eye colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors |
. s . ndex
which are similar before and after conversion,
x but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an
value (color temp.) image, you can print a natural-looking image in @ @
— | SRGB 2.2 6500K(D65) which the saturation has not changed greatly.
[ Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K (D65) cases where the overall tone of an image
————- ColorMatch RGB 1.8 5000K(D50) changes somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and hlghllghts Change. 110
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False Color REAUCTION ....ccviiee et 64, 65
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General Settings (Preferences) ..., 64
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General SETHNGS .....uvveiiieeeiiiiiie e 64
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VIBW SEIINGS oo 66
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Printing a Thumbnail List (Contact Sheet Printing) ...............coe..... 61
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Printing with a Large-Format Canon Printer ..........ccoevvvvvvviinnnnnn. 63
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Printing with Easy-PhotoPrint Pro .........ccccccccvviviiii 62

Printing with Shooting Information (Detailed Setting Printing)...... 60

Rendering Intents when Using Easy-PhotoPrint .................... 68, 69
Printing a Thumbnail List (Contact Sheet Printing) .............cccccvvvveeenn. 61
Printing One Sheet of Paper..........cvvvvviviiiiiiiieiiieiiiiieeeeeeeeeeeeeeeee 13, 40
Printing with a High-End Canon Printer .............cccccueeeeeiieeiieeeeeeeeeeeeee. 62
Printing with a Large-Format Canon Printer ...........cccccvvvvvvveevveeveeennnn.. 63
Printing with a Printer other than the Canon Printers...........cccccceue..... 40
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Printing with Easy-PhotoPrint EX.............uuvuvviiiiiiiiiiieiiieeiieeeeeeeeeeveneees, 35
Printing with Easy-PhotoPrint Pro................eeeeieeiiiiiieiiiiiiiiieeeiieeeeeeeeee 62
Printing with Shooting Information (Detailed Setting Printing) ............ 60
Q
QUICK CheCK WINAOW......uuiiiiiiiiiiieiice e 15, 101
R
RAW IMAGE. .. e 109
RAW TOOI PaleIe .....euviiiiiieiii e 11, 99
Re-Adjusting @n IMAJE ........uuuuiuiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeete e eeeeeeens 35,92
=T o] = S 71, 109
RECIPE il e 71
Re-Editing an IMAgE ..........uuuuuriiiiiiiiiiiiiireiiiirierereesessreeereeeeseresesreees 35, 92
Registering Folders as BOOKMArKS ..............uuuuuiiiiiimuiiiiiiiniiieiiinaeeeeinnns 43
ReName WINAOW..........uuiiiiiiiiiiiiiiceee e 76, 108
Rendering Intent (Matching Method) .........cccoeeviiiiiiiiiiiiiei, 110

Rendering Intents when Using Easy-PhotoPrint .................... 68, 69
Rendering Intents when Using Easy-PhotoPrint...........cccccc.cce...... 68, 69
Repair (Manual DUSE Erasure) ...........coouiiviiiiieeeenniiiiiiieeeeee s 58, 90
RGB TOOI PalELe .......uveeiiieeiiiiiiiiiieeee e 78, 99
RoOtate IMages........oi i 9, 21, 96, 101, 102
S
SAUrALION. ...eii i 82
Save

Batch Convert/Save Images (Batch Process)..........cccceeeuee. 74, 107

Convert to JPEG or TIFF Images and Save..........cccceeeee..... 34, 103

SV Lttt ettt ettt ettt e e e e e e eees 33,91
SV A 33,91
Save JPEG or TIFF Image as a Separate Image .............c........... 92
View and Save RAW IMages.......ccooeeeeeeiiiiiieeiees 64, 65
S T= AV ST 33,91
SAVING RECIPES. ... et 72
SeleCt IMAgES....ccoveeiieeieeeee 9, 15, 29
Shadow Area Warning INdiCatOr...........cceeviieiiiiieiiiiiee e 47
SNAIMPNESS ... 27,82
Shooting Information DiSplay...........ccuuuiiiiiieeiiieeeiee e 9, 20
SNOMCUL KEYS ...ttt Cover
Single Image Display ...........coooo i, 19
Single Image Display of RAW and JPEG Image..........ccccceveeeeiiiinnen. 19
Sorting Images (Check Marks) ...........cccccoeeeiei, 16, 17
RS 1= PRSPPI 110
Starting UPp DPP ..., 6
SUPPOIEA IMBGES ...t 3
Synchronization (Edit WindOW)............coooooiiiiiiii e, 46
Synchronize Edit WINAOWS ..........couiiiiiiiiiiiieeee e 46
SYNChronize IMAagES ........coooo e 46
SySteM REQUITEMENTS .....ueiiiiiiiiiiiiiiii et 3
T
Thumbnail Display (Main Window) .........ccoovviiiiiiiiiiiieeeeeeee 9, 96
Change the DiSPlay..........uuuuuuriiriiiiriiieiiieeieeeeeeeeeeeee e e e e eereees 9
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 29
Thumbnail Display of Images (Main Window) ............cccccoeeeeeiiiienn. 9
Change the DiSPlay ......... i ueeuueiiiiiiiiiiiiieieiieieeeeeeeeeee e 9
LI 11T T T 109
TONE CUINVE ... e e e s 109
Tone Curve AdJUSTMENT........cooviiiiiee e e 50, 83
Tone Curve Assist (Automatic Adjustment)...........ccceeevvviviineeeeenn. 28, 79
TONING EffECT oo 26
Tool Palette
NR/LeNs TOOol Palette...........uvvvvieeeiiiiiiiiieee e 100
RAW TOOI Palette .....ooovviiiiiiiiiiiieee 99
RGB TOOl Palette ....coovvvvieiiiiiiieeeeeee 99
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Tool Palette (PreferenCes) ........cuuvevieeiiiiiiiiiiiiiieiiieiieee et 67
Transfer
Batch Transfer Images to Image Editing Software...................... 75
Transfer an Image to Photoshop............ccceeiviiiiiiviciiice e 59
Transfer an Image to PhotoShOp ...........oovvvviiiiiiiiiiieeceeee 59
TAMMING @N IMAJE ...evvviiiiiiiieiiiiieeeeeeeeiee e e e e e aeeeeeeeeees 31, 86
TrmMMING WINAOW ......uvviiiiiiiiiiiiiiiiiiiiiiieeieeieeeeeeeeeeeeeeeeeeeeeee 31, 86, 104
\%
View Settings (PreferenCes) .........uuvvvvviiriiiiiiiiiiiiiiiriieeeeereissseeeseeenneeen 66
W
WHhite BalanCe.........uuiiiiiiiiiiece e e 23
Click White BalanCe .............uuuuuiiuiiiiiiiiiiieiiiieiiiieieeeeeeeeeeeeeeeeee 24,81
COlOr TEMPEIALUIE ....ceeiiiiiiiieeee e 48
COlOr WREEI.....eiiiiiiiiiiiiii e e e eeas 48
Personal White BalanCe .........c.cccccvvvvviiiiii 73
Wide GamUEt RGB ........uiiiiiiiiiiiiiiiiiecce et 110
WOTK COlOr SPACE......eeiiiiiiiiiiiiii e 59

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

© Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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